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1. INTRODUCTION

The RCM3600 is a compact module that incorporates the pow-
erful Rabbit 3000® microprocessor, flash memory, static RAM,
and digital 1/O ports.

The Development Kit has what you need to design your own
microprocessor-based system: a complete Dynamic C software
development system and a Prototyping Board that allows you to
evaluate the RCM3600 and to prototype circuits that interface to
the RCM3600 module.

The RCM3600 has a Rabbit 3000 microprocessor operating at 22.1 MHz, static RAM,
flash memory, two clocks (main oscillator and real-time clock), and the circuitry necessary
for reset and management of battery backup of the Rabbit 3000’s internal real-time clock
and the static RAM. One 40-pin header brings out the Rabbit 3000 1/O bus lines, parallel
ports, and serial ports.

The RCM3600 receives its +5 V power from the customer-supplied motherboard on
which it is mounted. The RCM3600 can interface with all kinds of CMOS-compatible
digital devices through the motherboard.

1.1 RCM3600 Features

Small size: 1.23" x 2.11" x 0.62"
(31 mm x 54 mm x 16 mm)

Microprocessor: Rabbit 3000 running at 22.1 MHz
33 parallel 5 V tolerant 1/O lines: 31 configurable for 1/O, 2 fixed outputs
External reset 1/0

Alternate 1/0 bus can be configured for 8 data lines and 5 address lines (shared with
parallel 1/O lines), 1/O read/write

Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers
512K flash memory, 512K SRAM (options for 256K flash memory and 128K SRAM)
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Real-time clock

Watchdog supervisor

Connections via header J1 for customer-supplied backup battery

10-bit free-running PWM counter and four pulse-width registers

Two-channel Input Capture can be used to time input signals from various port pins

Two-channel Quadrature Decoder accepts inputs from external incremental encoder
modules

Four available 3.3 V CMOS-compatible serial ports with a maximum asynchronous baud
rate of 2.76 Mbps. Three ports are configurable as a clocked serial port (SPI), and one
port is configurable as an HDLC serial port. Shared connections to the Rabbit micro-
processor make a second HDLC serial port available at the expense of two of the SPI
configurable ports, giving you two HDLC ports and one asynchronous/SPI serial port.

Supports 1.15 Mbps IrDA transceiver

There are two RCM3600 production models. If the standard models do not serve your
needs, variations can be specified and ordered in production gquantities. Contact your
Z-World or Rabbit Semiconductor sales representative for details.

Table 1 below summarizes the main features of the RCM3600.

Table 1. RCM3600 Features

Feature RCM3600 RCM3610
Microprocessor Rabbit 3000 running at 22.1 MHz
Flash Memory 512K 256K
SRAM 512K 128K

4 shared high-speed, 3.3 V CMOS-compatible ports:
all 4 are configurable as asynchronous serial ports;
3 are configurable as a clocked serial port (SPI) and
1 is configurable as an HDLC serial port;
option for second HDLC serial port at the expense
of 2 clocked serial ports (SPI)

Serial Ports

The RCM3600 can be programed through a USB port with an RS-232/USB converter, or
over an Ethernet with the RabbitLink.

Appendix A provides detailed specifications for the RCM3600.
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1.2 Advantages of the RCM3600

Fast time to market using a fully engineered, “ready-to-run/ready-to-program’ micro-
processor core.

Competitive pricing when compared with the alternative of purchasing and assembling
individual components.

Easy C-language program development and debugging

Program download utility (Rabbit Field Utility) and cloning board options for rapid
production loading of programs.

Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.
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1.3 Development and Evaluation Tools

1.3.1 Development Kit

The Development Kit contains the hardware you need to use your RCM3600 module.

RCM3600 module.
Prototyping Board.

AC adapter, 12 V DC, 500 mA (included only with Development Kits sold for the
North American market). A header plug leading to bare leads is provided to allow over-
seas users to connect their own power supply with a DC output of 7.5-30 V.

Programming cable with 10-pin header and DE9 connections, and integrated level-
matching circuitry.

Cable kits to access RS-485 and analog input connectors on Prototyping Board.
Dynamic C CD-ROM, with complete product documentation on disk.

Getting Started instructions.

Accessory parts for use on the Prototyping Board.

Rabbit 3000 Processor Easy Reference poster.

Registration card.

O >
Programming AC Adapter ‘ 55
DIAG Cable (North American
kits only) :

Tl Hoeoe=

e ﬁM —
Access%ry Parts for I%

i L Prototyping Board Wiring Cable Kits

PaSb#C orn BT WREE

Getting Started
Instructions

Prototyping Board

Figure 1. RCM3600 Development Kit
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1.3.2 Software

The RCM3600 is programmed using version 8.11 or later of Z-World’s Dynamic C. A
compatible version is included on the Development Kit CD-ROM.

Z-World also offers add-on Dynamic C modules including the popular uC/OS-II real-time
operating system, as well as point-to-pint protocol (PPP), Advanced Encryption Standard
(AES), and other select libraries. In addition to the Web-based technical support included
at no extra charge, a one-year telephone-based technical support module is also available
for purchase. Visit our Web site at www.zworld.com or contact your Z-World sales repre-
sentative or authorized distributor for further information.

1.3.3 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, use your browser to find and load default.htm in the docs
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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2. GETTING STARTED

This chapter describes the RCM3600 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: Itisassumed that you have the RCM3600 Development Kit. If you purchased an
RCM3600 module by itself or with another kit, you will have to adapt the information
in this chapter and elsewhere to your test and development setup.

2.1 Install Dynamic C

To develop and debug programs for the RCM3600 (and for all other Z-World and Rabbit
Semiconductor hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 8.11 (or a later version), do so now by
inserting the Dynamic C CD from the RCM3600 Development Kit in your PC’s CD-ROM
drive. If autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows
Start | Run menu or Windows Disk Explorer to launch set up. exe from the root folder
of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the
process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system.
The installation allows you to choose the COM port that will be used. The default selec-
tion is COM1. You may select any available port for Dynamic C’s use. If you are not cer-
tain which port is available, select COML1. This selection can be changed later within
Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-
fying a port in use by another device (mouse, modem, etc.) may lead to a message such
as"coul d not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three icons on your PC desktop.
One icon is for Dynamic C, one opens the documentation menu, and the third is for the
Rabbit Field Utility, a tool used to download precompiled software to a target system.
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2.2 Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the
sample programs:

1. Attach the RCM3600 module to the Prototyping Board.

2. Connect the programming cable between the RCM3600 Prototyping Board and the
workstation PC.

3. Connect the power supply to the Prototyping Board.
2.2.1 Attach Module to Prototyping Board

Turn the RCM3600 module so that the Rabbit 3000 chip is facing up as shown in Figure 2
below. Insert the module’s J1 header into the TCM_SMT_SOCKET socket on the Proto-
typing Board. The shaded corner notch at the bottom right corner of the RCM3600 module
should face the same direction as the corresponding notch below it on the Prototyping
Board.

RCM3600 %4lign shaded

S

I.X.X.X.X.I.X.A,!‘_
O
O

YOO000

$
ol

RCM36/37XX SERIES
ROTOTYPING BOARD.

)

Figure 2. Install the RCM3600 Series on the Prototyping Board

NOTE: Itisimportant that you line up the pins on header J1 of the RCM3600 module
exactly with the corresponding pins of the TCM_SMT_SOCKET socket on the Proto-
typing Board. The header pins may become bent or damaged if the pin alignment is off-
set, and the module will not work. Permanent electrical damage to the module may also
result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board headers.
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2.2.2 Connect Programming Cable

The programming cable connects the RCM3600 to the PC running Dynamic C to down-
load programs and to monitor the RCM3600 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on
the RCM3600 as shown in Figure 3. Be sure to orient the marked (usually red) edge of the

cable towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a
normal serial connection.)

AC Adapter

Programming
Cable

To
PC COM port

Blue ’ |
shrink wrap \ CoIored
edge

0000l

X

YOOOC

XC

30

oooooooooooooooooooooo 3-pin

o/slslelelelelolelolelslolelolelo eloleTs}
power connector

OOOOOOOOOOOOOOOOOOOOO
00000000000000000000
000000000000000000000

00000000000000000000
000000000000000000000
00000000000000000000
000000000000000000Q00
0000000000000000000000 QL |
0000000000000000000000000
OOOOOOOOOOOOOOOOOOOOOOOOO
IROOO00000000000000000000000
@0OOOOOOOOOOOOOOOOOOOOOOOOO

Q0000

0
o]
o]
o]
o]
o]
o]
o]
0
0
o]
0
o]
o]
o]
o]
0
0
0
o]
0

YO0OC
OOOOOOOO 0

Q00

ccccc

o

QO

OO0K

(X

XC

\— Reset switch

Figure 3. Connect Programming Cable and Power Supply

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this
Development Kit—the programming cable has blue shrink wrap around the RS-232 con-
verter section located in the middle of the cable. Programming cables from other Z-World
or Rabbit Semiconductor kits were not designed to work with RCM3600 modules.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. If your PC has no RS-232
COM port, but has a USB port, you should buy an RS-232/USB converter from
Z-World’s Web store.
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2.2.3 Connect Power

When all other connections have been made, you can connect power to the Prototyping
Board. Connect the wall transformer to 3-pin header J4 on the Prototyping Board as
shown in Figure 3. The connector may be attached either way as long as it is not offset to
one side.

Plug in the wall transformer. The LED above the RESET button on the Prototyping Board
should light up. The RCM3600 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow a hardware reset
without disconnecting power.

2.2.3.1 Overseas Development Kits

Development kits sold outside North America include a header connector that may be
connected to 3-pin header J4 on the Prototyping Board. The connector may be attached
either way as long as it is not offset to one side. The red and black wires from the connec-
tor can then be connected to the positive and negative connections on your power supply.
The power supply should deliver 7.5 V=30 V DC at 500 mA.
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2.3 Starting Dynamic C

Once the RCM3600 is connected as described in the preceding pages, start Dynamic C by
double-clicking on the Dynamic C icon or by double-clicking on dcr abXXXX. exe in
the Dynamic C root directory, where XXXX are version-specific characters.

Dynamic C uses the serial port on your PC that you specified during installation.
2.4 Run a Sample Program

Use the File menu to open the sample program PONG. C, which is in the Dynamic C
SAMPLES folder. Press function key F9 to compile and run the program. The STDIO win-
dow will open on your PC and will display a small square bouncing around in a box.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load the sample program, it is possible that
your PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

» Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

* Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Choose a lower debug baud rate.

If there are any other problems:

» Check that the RCM3600 is powered correctly — the power LED above the RESET
button on the Prototyping Board should be lit.

» Check to make sure you are using the PROG connector, not the DIAG connector, on the
programming cable.

» Check both ends of the programming cable to ensure that they are firmly plugged into
the PC and the programming port on the RCM3600.

» Ensure that the RCM3600 module is firmly and correctly installed in its connectors on
the Prototyping Board.

» Select a different COM port within Dynamic C. From the Options menu, select
Project Options, then select Communications. Select another COM port from the list,
then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C
still reports it is unable to locate the target system, repeat the above steps until you locate
the active COM port.
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2.5 Where Do | Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to
develop your own applications. The source code for the sample programs is provided to allow
you to modify them for your own use. The RCM3600 User’s Manual also provides com-
plete hardware reference information and describes the software function calls for the
RCM3600, the Prototyping Board, and the optional LCD/keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual, which is avail-
able in the online documentation set.

2.5.1 Standalone Operation of the RCM3600

The RCM3600 must be programmed via the RCM3600 Prototyping Board or via a similar
arrangement on a customer-supplied board. Once the RCM3600 has been programmed
successfully, remove the programming cable from the programming connector and reset
the RCM3600. The RCM3600 may be reset by removing, then reapplying power, or by
pressing the RESET button on the Prototyping Board. The RCM3600 module may now be
removed from the Prototyping Board for end-use installation.

CAUTION: Power to the Prototyping Board or other boards should be disconnected
when removing or installing your RCM3600 module to protect against inadvertent
shorts across the pins or damage to the RCM3600 if the pins are not plugged in cor-
rectly. Do not reapply power until you have verified that the RCM3600 module is
plugged in correctly.

2.5.2 Technical Support

NOTE: If you purchased your RCM3600 through a distributor or through a Z-World or
Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:

¢ Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at
www.zworld.com/support/bb/.

» Use the Technical Support e-mail form at www.zworld.com/support/support_submit.html.

12 RabbitCore RCM3600


http://www.zworld.com/support/bb/index.html
http://www.zworld.com/support/support_submit.html

3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3600 (and for all
other Z-World and Rabbit Semiconductor hardware), you must
install and use Dynamic C.

3.1 Introduction

To help familiarize you with the RCM3600 modules, Dynamic C includes several sample
programs. Loading, executing and studying these programs will give you a solid hands-on
overview of the RCM3600’s capabilities, as well as a quick start with Dynamic C as an
application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C
programming language. If you do not, see the introductory pages of the Dynamic C
User’s Manual for a suggested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3600 must be plugged in to the Prototyping Board as described in Chapter 2,
“Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the Prototyping
Board to your PC.

4. Power must be applied to the RCM3600 through the Prototyping Board.
Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu, compile it using the Compile menu
(or press F5), and then run it by selecting Run in the Run menu (or press F9). The
RCM3600 must be in Program Mode (see Figure 8) and must be connected to a PC using
the programming cable.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.2 Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the
RCM3600. Sample programs illustrating the general operation of the RCM3600, serial
communication, and the A/D converter on the Prototyping Board are provided in the
SAMPLES\ RCVB600 folder. Each sample program has comments that describe the purpose
and function of the program. Follow the instructions at the beginning of the sample pro-
gram. Note that the RCM3600 must be installed on the Prototyping Board when using
these sample programs. Sample programs for the optional LCD/keypad module are
described in Appendix C.

* CONTROLLED. c—Demonstrates use of the digital inputs by having you turn the LEDs
on the Prototyping Board on or off from the STDIO window on your PC.

Once you compile and run CONTROLLED. C, the following display will appear in the
Dynamic C STDIO window.

E_ﬁlﬁ

oo Proto-boaea LED'a o
nsl s ¥

o OrFr

From PC k=vhomcd:

Select 1=031 or =03 to toggle LED'a

< Fr=a= 2 To Quib =

o .

Press “1” or “2” on your keyboard to select LED DS1 or DS2 on the Prototyping
Board. Then follow the prompt in the Dynamic C STDIO window to turn the LED
on or off.
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* FLASHLED. c—Demonstrates assembly-language program by flashing LEDs DS1 and
DS2 on the Prototyping Board at different rates.

* | R_DEMO. c—Demonstrates sending Modbus ASCII packets between two
RCM3600/Prototyping Board assemblies via the IrDA transceivers.

* DI O. c—Demonstrates the digital I/O capabilities of the A/D converter on the Proto-
typing Board by configuring two lines to outputs and two lines as inputs on Prototyping
Board header JP4.

Install a 2 x 2 header at JP4 and connect pins 1-2 and pins 3—4 on header JP4 before
running this sample program.

* TOGGLESW TCH. c—Uses costatements to detect switches using debouncing. The cor-
responding LEDs (DS1 and DS2) will turn on or off.

Once you have loaded and executed these five programs and have an understanding of
how Dynamic C and the RCM3600 modules interact, you can move on and try the other
sample programs, or begin building your own.

3.2.1 Serial Communication
The following sample programs can be found in the SERI AL folder in SAMPLES\ RCV3600.

* FLOACONTROL. G—This program demonstrates hardware flow control by configuring
Serial Port C for CTS/RTS with serial data coming from Serial Port D. The serial data
received are displayed in the STDIO window.

* PARI TY. G—This program demonstrates the use of parity modes by repeatedly sending
byte values 0-127 from Serial Port D to Serial Port C. The program will switch
between generating parity or not on Serial Port D. Serial Port C will always be check-
ing parity, so parity errors should occur during every other sequence.

* S| MPLE3W RE. G—This program demonstrates basic RS-232 serial communication.
* S| MPLESW RE. CG—This program demonstrates 5-wire RS-232 serial communication.

* SW TCHCHAR. G—This program demonstrates transmits and then receives an ASCII
string on Serial Ports C and E. It also displays the serial data received from both ports
in the STDIO window.

Before running this sample program, check to make sure that Serial Port E is set up as
an RS-232 serial port—pins 1-3 and pins 2—4 on header JP2 must be jumpered
together. Then connect TxC to RXE and connect RXC to TXE. These connections can be
made using the pins on header J2.

* S| MPLE485MASTER. C—This program demonstrates a simple RS-485 transmission of
lower case letters to a slave RCM3600. The slave will send back converted upper case
letters back to the master RCM3600 and display them in the STDIO window. Use
S| MPLE485SLAVE. Cto program the slave RCM3600, and check to make sure that
Serial Port E is set up as an RS-485 serial port—pins 3-5 and pins 4-6 on header JP2
must be jumpered together.
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S| MPLE485LAVE. C—This program demonstrates a simple RS-485 transmission of
lower case letters to a master RCM3600. The slave will send back converted upper case
letters back to the master RCM3600 and display them in the STDIO window. Use

S| MPLE485MASTER. Cto program the masterRCM3600, and check to make sure that
Serial Port E is set up as an RS-485 serial port—pins 3-5 and pins 4—6 on header JP2
must be jumpered together.

3.2.2 A/D Converter Inputs
The following sample programs are found in the ADC folder in SAMPLES\ RCM3600.

AD_CALDI FF_CH. C—Demonstrates how to recalibrate one differential analog input
channel using two known voltages to generate the calibration constants for that channel.
Constants will be rewritten into user block data area.

AD_CALMA CH. C—Demonstrates how to recalibrate an A/D input channel being used to
convert analog current measurements to generate the calibration constants for that channel.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7. Connect pins 1-2, 3—-4, 5-6, 7-8 on header JP8.

AD_CALSE_ALL. C—Demonstrates how to recalibrate all single-ended analog input
channels for one gain, using two known voltages to generate the calibration constants
for each channel. Constants will be rewritten into the user block data area.

AD_CALSE_CHAN. C—Demonstrates how to recalibrate one single-ended analog input
channel with one gain using two known voltages to generate the calibration constants
for that channel. Constants will be rewritten into user block data area.

NOTE: The above sample programs will overwrite any existing calibration constants.

AD_RDDI FF_CH. C—Demonstrates how to read an A/D input channel being used for a
differential input using previously defined calibration constants.

AD_RDMVA CH. G—Demonstrates how to read an A/D input channel being used to con-
vert analog current measurements using previously defined calibration constants for
that channel.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7. Connect pins 1-2, 3—-4, 5-6, 7-8 on header JP8.

AD_RDSE_ALL. G—Demonstrates how to read all single-ended A/D input channels
using previously defined calibration constants.

AD_SAMPLE. GC—Demonstrates how to use a low-level driver on single-ended inputs.
The program will continuously display the voltage (average of 10 samples) that is
present on the A/D channels.

ANAI NCONFI G. G—Demonstrates how to use the Register Mode method to read single-
ended analog input values for display as voltages. The sample program uses the func-
tion call anal nConfi g() and the ADS7870 CONVERT line to accomplish this task.
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* THERM STOR. G—Demonstrates how to use analog input THERM _IN7 to calculate
temperature for display to the STDIO window. This sample program assumes that the
thermistor is the one included in the Development Kit whose values for beta, series
resistance, and resistance at standard temperature are given in the part specification.

* DNLOADCALI B. G—Demonstrates how to retrieve analog calibration data to rewrite it
back to simulated EEPROM in flash with using a serial utility such as Tera Term.

* UPLOADCALI B. G—Demonstrates how to read calibrations constants from the user
block in flash memory and then transmitting the file using a serial port and a PC serial

utility such as Tera Term. Use DNLOADCALI B. Cto download the calibration constants
created by this program.
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4. HARDWARE REFERENCE

Chapter 4 describes the hardware components and principal hardware
subsystems of the RCM3600. Appendix A, “RCM3600 Specifica-
tions,” provides complete physical and electrical specifications.

Figure 4 shows the Rabbit-based subsystems designed into the RCM3600.

32 kHz || 11 MHz
osc osc Customer-specific
applications
SRAM RABBIT CMOS-level signals
Flash 3000 Level
converter
|
Battery-Backup RS-232, RS-485, IrDA
Circuit serial communication
drivers on motherboard
= Customer-supplied
RabbitCore Module T external 3 V battery

Figure 4. RCM3600 Subsystems
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4.1 RCM3600 Digital Inputs and Outputs
Figure 5 shows the RCM3600 pinouts for header J1.

Header J1 is a standard 2 x 20 IDC header with a nominal 0.1" pitch.

J1
PA6 |0 m[ ] PA7
PA4[|o o[ 1PA5
PA2 | = o[ 1PA3
PAOL |0 o[ ]PA1
PFOL |5 o[ JPF1
PB2[ | o o[ 1PBO
PB4 |o o[ 1PB3
PB7[ o o[ 1PB5
PF5L_| o o[ 1PF4
PF7L o o[ 1PF6
PC1/PG2 Lo o[ JPCO
PC3/PG3[ |0 o[ 1PC2
PES[ |0 o[ 1PE7
PE1[|o o[ _]PE4
PG7[ o o[ 1PEO
IOWR Lo ol 1PG6
PD4L_|o ol J/IORD
/RESL] o o[ ]PD5
GND L |5 © [ JVBAT_EXT
GNDL |5 o[ JVIN

Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 5. RCM3600 Pinouts
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Figure 6 shows the use of the Rabbit 3000 microprocessor ports in the RCM3600 modules.

PCO, PC2

PG2-PG3
PG6-PG7

PC6

PB1, PC7, IRES,
STATUS,
SMODEO, SMODE1

PC1, PC3 I

-

5

-
-
-
ﬁ

PBO, PB7,
PAO-PAT PB2-PB5 PD4—PD5
Port D
PortA Port B (+Ethernet Port)
Port C Port E
(Serial Ports C & D) RABBIT
3000 Port F
Port G
(Serial Ports E & F) Real-Time Clock
Watchdog
Programming 11 Timers Misc. /10
Port
(SerialoPort A) SlavelEoi
Clock Doubler
RAM Backup Battery Flash

Support

PEO-PE1,
PE4-PES,

PE7

PF4-PF7

/IRES
/IORD

/RES,
/IOWR

Figure 6. Use of Rabbit 3000 Ports

The ports on the Rabbit 3000 microprocessor used in the RCM3600 are configurable, and
so the factory defaults can be reconfigured. Table 2 lists the Rabbit 3000 factory defaults
and the alternate configurations.
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Table 2. RCM3600 Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
External data bus
IDO-ID7
1-8 PA[7:0] Parallel I/0 ( ) External Data Bus
Slave port data bus
(SD0-SD7)
QD1A
9 PF1 Input/Output CLKC
QD1B
10 PFO Input/Output CLKD
11 PBO Input/Output CLKB
IA0 External Address 0
12 PB2 Input/Output .
pubrbutpu /SWR Slave port write
IA1 External Address 1
13 PB3 Input/Output ISRD Slave port read
IA2 External Address 2
14 PB4 Input/Output SAO Slave Port Address 0
IA3 External Address 3
. 15 PBS Input/Output SA1l Slave Port Address 1
g IA5 External Address 5
% 16 PB7 Input/Output /SLAVEATTN Slave Port Attention
AQDI1B
17 PF4 Input/Output PWMO
AQDIA
18 PF5 Input/Output PWML
AQD2B
19 PF6 Input/Output Q
PWM2
AQD2A
20 PF7 Input/Output PWM3
21 PCO Output TXD Serial Port D
Serial Port D
22 PC1/PG2 Input/Output RXD/TXF Serial Port F
23 PC2 Output TXC Serial Port C
Serial Port C
24 PC3/PG3 Input/Output RXC/RXF Serial Port F
17 External Address 7
25 PET Input/Output /SCS Slave Port Chip Select
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Table 2. RCM3600 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
26 PE5 Input/Output 15
putidtp INT1B
27 PE4 Input/Output 14
pUERLD INTOB
11 1/0O Strobe 1
28 PE1 Input/Output
purbutpu INT1A Interrupt 1A
10 1/O Strobe 0
29 PEO Input/Output
npuvUtpu INTOA Interrupt OA
30 PG7 Input/Output RXE
Serial Port E
= |31 PG6 Input/Output TXE
S |32 /IOWR Output External write strobe
D
T 33 /IORD Input External read strobe
34 PD4 Input/Output ATXB
Alternate Serial Port B
35 PD5 Input/Output ARXB
36 IRES Reset output Reset input Reset output from Reset
Generator
37 VBAT
38 GND
39 +5V
40 GND
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4.1.1 Memory I/O Interface

The Rabbit 3000 address lines (A0-A18) and all the data lines (D0-D7) are routed inter-
nally to the onboard flash memory and SRAM chips. 1/0 write (/IOWR) and 1/0 read
(/IORD) are available for interfacing to external devices.

Parallel Port A can also be used as an external I/O data bus to isolate external 1/0 from the
main data bus. Parallel Port B pins PB2—PB5 and PB7 can also be used as an auxiliary
address bus.

When using the auxiliary 1/0O bus for either Ethernet or the LCD/keypad module on the
Prototyping Board, or for any other reason, you must add the following line at the begin-
ning of your program.

#defi ne PORTA _AUX | O // required to enable auxiliary I/0 bus

4.1.2 Other Inputs and Outputs

/RES is an output from the reset circuitry that can be used to reset other peripheral devices.
This pin can also be used to reset the microprocessor.
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4.2 Serial Communication

The RCM3600 board does not have any serial transceivers directly on the board. How-
ever, a serial interface may be incorporated on the board the RCM3600 is mounted on. For
example, the Prototyping Board has RS-232, RS-485 and IrDA transceiver chips.

4.2.1 Serial Ports

There are five serial ports designated as Serial Ports A, C, D, E, and F. All five serial ports
can operate in an asynchronous mode up to the baud rate of the system clock divided by 8.
An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an
additional bit is sent to mark the first byte of a message, is also supported.

Serial Port A is normally used as a programming port, but may be used either as an asyn-
chronous or as a clocked serial port once the RCM3600 has been programmed and is oper-
ating in the Run Mode.

Serial Ports C and D can also be operated in the clocked serial mode. In this mode, a clock
line synchronously clocks the data in or out. Either of the two communicating devices can
supply the clock.

Serial Ports E and F can also be configured as HDLC serial ports. The IrDA protocol is
also supported in SDLC format by these two ports.

Either Serial Ports C and D or Serial Port F can be used at one time because these ports
share some common pins on header J1, as shown in Figure 7. The selection of port(s)
depends on your need for two clocked serial ports (Serial Ports C and D) vs. a second
HDLC serial port (Serial Port F).

J1: 23 TXC
J1: 24 RXC
J1: 21 1XD
RXD
J1: 22
TXF
RXF

Figure 7. RCM3600 Serial Ports C, D, and F

The serial ports used are selected with the ser XOpen function call, where X is the serial
port (C, D, or F). Remember that Serial Ports C and D cannot be used if Serial Port F is
being used
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4.2.2 Programming Port

Serial Port A has special features that allow it to cold-boot the system after reset. Serial
Port A is also the port that is used for software development under Dynamic C.

The RCM3600 is accessed using a 10-pin program header labeled J2. The programming
port uses the Rabbit 3000’s Serial Port A for communication, and is used for the following
operations.

* Programming/debugging
» Cloning

* Remote program download/debug over an Ethernet connection via the RabbitLink
EG2100

The Rabbit 3000 startup-mode pins (SMODEO, SMODE1) are presented to the program-
ming port so that an externally connected device can force the RCM3600 to start up in an
external bootstrap mode. The RCM3600 can be reset by Dynamic C via the /RESET line
on the programming port.

The Rabbit 3000 status pin is also presented to the programming port. The status pin is an
output that can be used to send a general digital signal.

The clock line for Serial Port A is presented to the programming port, which makes syn-
chronous serial communication possible.

The programming port is used to start the RCM3600 in a mode where the RCM3600 will
download a program from the port and then execute the program. The programming port
transmits information to and from a PC while a program is being debugged.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information.
4.2.2.1 Alternate Uses of the Programming Port

The programming port may also be used as an application port with the DIAG connector
on the programming cable.

All three clocked Serial Port A signals are available as

 asynchronous serial port

 an asynchronous serial port, with the clock line usable as a general CMOS input
* two general-purpose CMOS inputs and one general-purpose CMOS output.

Two startup-mode pins, SMODEO and SMODEL, are available as general CMOS inputs
after they are read during the initial boot-up. The logic state of these two pins determines
the startup procedure after a reset.

/RESET is an external input used to reset the Rabbit 3000 microprocessor.

The status pin may also be used as a general-purpose CMOS output.
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4.3 Programming Cable

The RCM3600 is automatically in program mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in run mode when no programming cable
is attached.

The DIAG connector of the programming cable may be used on header J2 of the RCM3600
Prototyping Board with the RCM3600 operating in the run mode. This allows the pro-
gramming port to be used as a regular serial port.

RESET RCM3600 when changing mode:

Programming Press RESET button (if using Prototyping Board), OR
Cable Remove, then reapply power
after removing or attaching programming cable.
To
PC COM port

Blue M

shrink wrap™\"" Colored : g = o0k
edge

00,

SOOOT
QOO0

SOC
QO

vvvvvvv

0,

000 000000000
QQQ0QQ0000E000000000

ARRRA

200000000000000
E RESET 20000000000000000

Y

Figure 8. Switching Between Program Mode and Run Mode

ROTOTYPING BOARC

Q 5

RCM36/37XX SERIES

2000000
0000000000000000A0A00 O
8888888588588585685855388

4.3.1 Changing from Program Mode to Run Mode

1. Disconnect the programming cable from header J2 on the RCM3600.
2. Reset the RCM3600. You may do this as explained in Figure 8.

The RCM3600 is now ready to operate in the run mode.

4.3.2 Changing from Run Mode to Program Mode

1. Attach the programming cable to header J2 on the RCM3600.

2. Reset the RCM3600. You may do this as explained in Figure 8.

The RCM3600 is now ready to operate in the program mode.
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4.4 Other Hardware
4.4.1 Clock Doubler

The RCM3600 takes advantage of the Rabbit 3000 microprocessor’s internal clock dou-
bler. A built-in clock doubler allows half-frequency crystals to be used to reduce radiated
emissions. The 22.1 MHz frequency specified for the RCM3600 is generated using a
11.06 MHz resonator.

The clock doubler may be disabled if 22.1 MHz clock speeds are not required. This will
reduce power consumption and further reduce radiated emissions. The clock doubler is
disabled with a simple change to the BIOS as described below.

1. Open the BIOS source code file, RABBI TBI CS. Cin the Bl OS directory.

2. Change the line

#define CLOCK DOUBLED 1 // set to 1 to double clock if
/1 Rabbit 2000: crystal <= 12.9024 Mz,
/1 Rabbit 3000: crystal <= 26.7264 Mz,
/1 or to 0 to always disable clock doubler

to read as follows.
#defi ne CLOCK _DOUBLED 0
3. Save the change using File > Save.

4.4.2 Spectrum Spreader

The Rabbit 3000 features a spectrum spreader, which helps to mitigate EMI problems. The
spectrum spreader is on by default, but it may also be turned off or set to a stronger setting
by changing the following macro in the BIOS.

#def i ne ENABLE_SPREADER 1 /1 Set to 0 to disable spectrum spreader,
/1 1 to enable normal spreading, or
/1 2 to enable strong spreading.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information
on the spectrum-spreading setting and the maximum clock speed.
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4.5 Memory

45.1 SRAM

RCM3600 series boards have 256K-512K of SRAM packaged in a 32-pin STSOP case.
4.5.2 Flash EPROM

RCM3600 series boards also have 256K-512K of flash EPROM packaged in a 32-pin
STSOP case.

NOTE: Z-World recommends that any customer applications should not be constrained
by the sector size of the flash EPROM since it may be necessary to change the sector
size in the future.

Writing to arbitrary flash memory addresses at run time is also discouraged. Instead, use a
portion of the “user block™ area to store persistent data. The function callswr i t eUser -
Bl ock and r eadUser Bl ock are provided for this. Refer to the Rabbit 3000 Micropro-
cessor Designer’s Handbook for additional information.

A Flash Memory Bank Select jumper configuration option based on 0 Q surface-mounted
resistors exists at header JP1 on the RCM3600 modules. This option, used in conjunction
with some configuration macros, allows Dynamic C to compile two different co-resident
programs for the upper and lower halves of the 512K flash in such a way that both pro-
grams start at logical address 0000. This is useful for applications that require a resident
download manager and a separate downloaded program. See Technical Note TN218,
Implementing a Serial Download Manager for a 256K Flash, for details.

4.5.3 Dynamic C BIOS Source Files

The Dynamic C BIOS source files handle different standard RAM and flash EPROM sizes
automatically.
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5. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Z-World controllers and other controllers
based on the Rabbit microprocessor. Chapter 5 describes the
libraries and function calls related to the RCM3600.

5.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging. A com-
plete reference guide to Dynamic C is contained in the Dynamic C User’s Manual.

You have a choice of doing your software development in the flash memory or in the static
SRAM included on the RCM3600. The advantage of working in RAM is to save wear on
the flash memory, which is limited to about 100,000 write cycles. The disadvantage is that
the code and data might not both fit in RAM.

NOTE: An application can be compiled in RAM, but cannot run standalone from RAM
after the programming cable is disconnected. All standalone applications can only run
from flash memory.

NOTE: Do not depend on the flash memory sector size or type in your program logic.
The RCM3600 and Dynamic C were designed to accommodate flash devices with
various sector sizes in response to the volatility of the flash-memory market.

The disadvantage of using flash memory for debug is that interrupts must be disabled for
approximately 5 ms whenever a break point is set in the program. This can prevent fast
interrupt routines from running when you set a break point. The flash memory and SRAM
options are selected with the Options > Program Options > Compiler menu.

Dynamic C provides a number of debugging features. You can single-step your program,
either in C, statement by statement, or in assembly language, instruction by instruction.
You can set break points to stop the program, and you can evaluate watch expressions. A
watch expression is any C expression that can be evaluated in the context of the program.
You can evaluate watch expressions by hitting <Ctrl-U> without stopping the program,
and they are evaluated automatically every time the program stops at a break point or at
each single-step.
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5.2 Dynamic C Functions

The functions described in this section are for use with the Prototyping Board features.
The source code is in the RCM36xx. LI B library in the Dynamic C SAMPLES\ RCM3600
folder if you need to modify it for your own board design.

Other generic functions applicable to all devices based on Rabbit microprocessors are
described in the Dynamic C Function Reference Manual.

5.2.1 Board Initialization

void brdinit (void);

Call this function at the beginning of your program. This function initializes Parallel Ports A through G
for use with the RCM3600 Prototyping Board.

Summary of Initialization

1.

© ®© N o g~ wDd

1/0 port pins are configured for Prototyping Board operation.
Unused configurable 1/O are set as tied inputs or outputs.
The LCD/keypad module is disabled.

RS-485 is not enabled.

RS-232 is not enabled.

The IrDA transceiver is disabled.

LEDs are off.

The A/D converter is reset and SCLKB is to 57,600 bps.

The A/D converter calibration constants are read (this function cannot run in RAM).

CAUTION: Pin PB7 is connected as both switch S2 and as an external 1/0 bus on the Prototyping
Board. Do not use S2 when the LCD/keypad module is installed.

CAUTION: Pins PC1 and PG2 are tied together, and pins PC3 and PG3 are tied together. Both
pairs of pins are connected to the IrDA transceiver and to the RS-232 transceiver via serial ports
on the Prototyping Board. Do not enable both transceivers on the Prototyping Board at the same
time.

RETURN VALUE
None.
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5.2.2 Analog Inputs

unsi gned i nt anal nConfi g(unsi gned i nt

I nstructi onbyte,

unsi gned int cnd,

| ong baud);

Use this function to configure the ADS7870 A/D converter. This function will address the ADS7870 in
Register Mode only, and will return error if you try the Direct Mode. This appendix provides additional
addressing and command information.

ADS7870 Signal | ADS7870 State RCM3600 Function/State

LNO Input AINO
LN1 Input AIN1
LN2 Input AIN2
LN3 Input AIN3
LN4 Input AIN4
LN5 Input AINS5
LN6 Input AING
LN7 Input AIN7

/IRESET Input Board reset device

RISE/FALL Input Pulled up for SCLK active on rising edge

P100 Input Pulled down
PIO1 Input Pulled down

P102 Input Pulled down

P103 Input Pulled down

CONVERT Input Pulled down
BUSY Output PD1 pulled down; logic high state converter is busy
CCLKCNTRL Input Pulled down; 0O state sets CCLK as input

CCLK Input Pulled down; external conversion clock

SCLK Input PBO; serial data transfer clock
SDI Input PD4; 3-wire mode for serial data input
SDO Output PD5; serial data output /CS driven
ICS Input PD2 pulled up; active-low enables serial interface

BUFIN Input Driven by VREF; reference buffer amplifier

VREF Output Connected to BUFIN

BUFOUT Output VREF output
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PARAMETERS

i nst ructi onbyt e is the instruction byte that will initiate a read or write operation at 8 or 16 bits on
the designated register address. For example,

checki d = anal nConfi g(0x5F, 0, 9600); // read ID and set baud rate

crd are the command data that configure the registers addressed by the instruction byte. Enter 0 if you
are performing a read operation. For example,

i = anal nConfig(0x07, 0x3b, 0); // wite ref/osc reg and enabl e

baud is the serial clock transfer rate of 9600 to 57,600 bps. baud must be set the first time this function
is called. Enter O for this parameter thereafter, for example,

anal nConfi g(0x00, 0x00, 9600); // resets device and sets baud
RETURN VALUE

0 on write operations,
data value on read operations

SEE ALSO
anal nDriver, analn, brdlnit
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unsi gned int analnDriver(unsigned int cnd,
unsigned int |en);

Reads the voltage of an analog input channel by serial-clocking an 8-bit command to the ADS7870 A/D
converter by the Direct Mode method. This function assumes that Model (most significant byte first) and
the A/D converter oscillator have been enabled. See anal nConf i g() for the setup.

The conversion begins immediately after the last data bit has been transferred. An exception error will
occur if Direct Mode bit D7 is not set.
PARAMETERS
cd contains a gain code and a channel code as follows.
D7—1; D6-D4—Gain Code; D3-D0—Channel Code
Use the following calculation and the tables below to determine cnd:
cmd = 0x80 | (gain_code*16) + channel _code

Gain Code Multiplier

0 x1

1 X2

2 x4

3 x5

4 x8

5 x10

6 x16

7 x20

Channel Code D|fferiri1r:|i Input Channel Code SIanngLIEi:;izg 4—|_2igen;A

0 +AINO -AIN1 8 AINO AINO*
+AIN2 -AIN3 9 AIN1 AIN1*
2 +AIN4 -AINS 10 AIN2 AIN2*
3f +AING -AIN7 11 AIN3 AIN3
4 -AINO +AIN1 12 AIN4 AIN4
-AIN2 +AIN3 13 AIN5 AIN5
6 -AIN4 +AIN5 14 AING AING
7* -AING +AIN7 15 AIN7 AINT*

* Negative input is ground.
t Not accessible on RCM3600 Prototyping Board

| en, the output bit length, is always 12 for 11-bit conversions

RETURN VALUE
A value corresponding to the voltage on the analog input channel:

0-2047 for 11-bit conversions (bit 12 for sign)
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-1 overflow or out of range
-2 conversion incomplete, busy bit timeout

SEE ALSO
anal nConfig, analn, brdlnit
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unsi gned i nt anal n(unsi gned int channel,
I nt opnode, int gai ncode);

Reads the value of an analog input channel using the direct method of addressing the ADS7870 A/D
converter. The A/D converter is enabled the first time this function is called—this will take approxi-
mately 1 second to ensure that the A/D converter capacitor is fully charged.

PARAMETERS
channel is the channel number (0 to 7) corresponding to ADC_INO to ADC_IN7
opnode is the mode of operation:
SI NGLE—single-ended input
DI FF—differential input
MAMP—4-20 mA input

channel SI NGLE DI FF MAVP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS5 -AIN4* +AIN5
6 +AING +AING -AIN7* +AING
7 +AIN7 +AIN7 -AIN6* +AINT*

* Not accessible on RCM3600 Prototyping Board.

gai ncode is the gain code of 0 to 7

Voltage Range”
Gain Code Multiplier
V)
0 x1 0-20
1 X2 0-10
2 x4 0-5
3 X5 0-4
4 X8 0-2.5
5 x10 0-2
6 x16 0-1.25
7 x20 0-1

*

>

pplies to RCM3600 Prototyping Board.
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RETURN VALUE
A value corresponding to the voltage on the analog input channel:
0-2047 for 11-bit A/D conversions (signed 12th bit)

ADOVERFLOW/(defined macro = -4096) if overflow or out of range
-4095 if conversion is incomplete or busy-bit timeout

SEE ALSO
anal n, analnConfig, analnDriver
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i nt analnCalib(int channel,
I nt gai ncode,
i nt val ue2,

i nt val uel,

float volts2);

I nt opnode,
float voltsl,

Calibrates the response of the desired A/D converter channel as a linear function using the two conver-
sion points provided. Four values are calculated and placed into global tables to be later stored into sim-

ulated EEPROM using the function anal nEEW () . Each channel will have a linear constant and a

voltage offset.

PARAMETERS

channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7

opnode is the mode of operation:

SI NGLE—single-ended input
DI FF—differential input
mANMP—milliamp input

channel SI NGLE DI FF MAVP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS5 -AIN4* +AIN5
6 +AING +AING -AIN7* +AIN6
7 +AIN7 +AIN7 -AIN6* +AINT*

* Not accessible on Prototyping Board.

gai ncode is the gain code of 0 to 7

Gain Code Multiplier Voltage Range’

V)

0 x1 0-20

1 x2 0-10
2 x4 0-5
3 x5 0-4

4 x8 0-2.5
5 x10 0-2

6 x16 0-1.25
7 x20 0-1
* Applies to RCM3600 Prototyping Board.
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val uel is the first A/D converter channel value (0-2047)

vol t s1 is the voltage or current corresponding to the first A/D converter channel value (0 to +20 V or
4 t0 20 mA)

val ue2 is the second A/D converter channel value (0-2047)

vol t s2 is the voltage or current corresponding to the first A/D converter channel value (0 to +20 V or
4 t0 20 mA)

RETURN VALUE

0 if successful.

-1 if not able to make calibration constants.

SEE ALSO

anal n, analnVolts, anal nmAnps, analnDiff, analnCalib, brdlinit
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fl oat anal nVol t s(unsi gned i nt
unsi gned i nt gai ncode) ;

channel ,

Reads the state of a single-ended analog input channel and uses the calibration constants previously set

using anal nCal i b to convert it to volts.

PARAMETERS
channel is the channel number (0-7)

Channel Code Sllnnpgulf_LEi:::fj Voltag ((avl)?ange'f
0 +AINO 0-20
1 +AIN1 0-20
2 +AIN2 0-20
3 +AIN3 0-20
4 +AIN4 0-20
5 +AIN5 0-20
6 +AING 0-20
7 +AIN7 02t

* Negative input is ground.

t Applies to RCM3600 Prototyping Board.
1 Used for thermistor in sample program.

gai ncode is the gain code of 0 to 7

Gain Code | Multiplier | Voltage Range’

V)

0 x1 0-20

1 X2 0-10
2 x4 0-5
3 x5 0-4

4 x8 0-25
5 x10 0-2

6 x16 0-1.25
7 x20 0-1
* Applies to RCM3600 Prototyping Board.

RETURN VALUE

A voltage value corresponding to the voltage on the analog input channel.
ADOVERFL OW/(defined macro = -4096) if overflow or out of range.

SEE ALSO
anal nCal i b, anal n, anal nmAnps, brdlnit
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fl oat anal nDi ff(unsigned int channel,
unsi gned i nt gai ncode) ;

Reads the state of differential analog input channels and uses the calibration constants previously set

using anal nCal i b to convert it to volts.

PARAMETERS

channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7

channel Dl FE Voltage Range

V)

0 +AINO -AINL 20t0 +20"

1 +AIN1 -AINO _

2 +AIN2 -AIN3 -20 to +20*

3 +AIN3 -AIN2 _

4 +AIN4 -AIN5 -20 to +20*

5 +AIN5 -AIN4 _

6 +AING -AIN7 _

7 +AIN7 -AIN6 _

* Applies to RCM3600 Prototyping Board.

gai ncode is the gain code of 0 to 7

Gain Code | Multiplier | Voltage Range’

V)

0 x1 0-20

1 X2 0-10

2 x4 0-5

3 x5 0-4

4 x8 0-25

5 x10 0-2

6 x16 0-1.25

7 x20 0-1

* Applies to RCM3600 Prototyping Board.

RETURN VALUE
A voltage value corresponding to the voltage on the analog input channel.

ADOVERFL OW(defined macro = -4096) if overflow or out of range.

SEE ALSO
anal nCal i b, analn, anal nmAnps, brdlnit
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I nt anal nmAnps(unsi gned i nt channel);

Reads the state of an analog input channel and uses the calibration constants previously set using
anal nCal i b to convert it to current.

PARAMETERS
channel is the channel number (0-7)

4-20 mA
Input Lines”

+AINO
+AIN1
+AIN2

Channel Code

+AIN3T
+AIN4*
+AIN5*
+AIN6*
+AIN7

N ol o b~ W[N], O

* Negative input is ground.
t Applies to RCM3600 Prototyp-
ing Board.

RETURN VALUE
A current value between 4.00 and 20.00 mA corresponding to the current on the analog input channel.

ADOVERFL OW/(defined macro = -4096) if overflow or out of range.

SEE ALSO
anal nCal i b, analn, analnVolts
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root int anal nEERd(unsi gned int channel,

unsi gned i nt opnode,

unsi gned i nt gai ncode);

Reads the calibration constants, gain, and offset for an input based on their designated position in the
simulated EEPROM area of the flash memory, and places them into global tables for analog inputs. The
constants are stored in the top 2K of the reserved user block memory area 0x1C00-0x1FFF. Depending
on the flash size, the following macros can be used to identify the starting address for these locations.

ADC _CALI B_ADDRS, address start of single-ended analog input channels
ADC_CALI B_ADDRD, address start of differential analog input channels
ADC_CALI B_ADDRM address start of milliamp analog input channels

NOTE: This function cannot be run in RAM.

PARAMETER

channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7

opnode is the mode of operation:
SI NGLE—single-ended input line

DI FF—differential input line

mANMP—milliamp input line

channel S| NGLE Dl FF mAMP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS5 -AIN4* +AINS
6 +AING +AING -AIN7* +AING6
7 +AIN7 +AIN7 -AIN6* +AINT7*

ALLCHAN read all channels for selected opnode

* Not accessible on Prototyping Board.
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gai ncode is the gain code of 0 to 7. The gai ncode parameter is ignored when channel is ALLCHAN.

Gain Code | Voltage Range”
V)
0-20
0-10
0-5
0-4
0-2.5
0-2
0-1.25
7 0-1

* Applies to RCM3600 Prototyping
Board.

OO0~ WINIEFL O

RETURN VALUE
0 if successful.
-1 if address is invalid or out of range.
SEE ALSO
anal nEEW, analnCalib
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I nt anal nEEW (unsi gned i nt channel, int opnode
unsi gned i nt gai ncode);
Writes the calibration constants, gain, and offset for an input based from global tables to designated posi-
tions in the simulated EEPROM area of the flash memory. The constants are stored in the top 2K of the

reserved user block memory area 0x1C00-0x1FFF. Depending on the flash size, the following macros
can be used to identify the starting address for these locations.

ADC_CALI B_ADDRS, address start of single-ended analog input channels
ADC_CALI B_ADDRD, address start of differential analog input channels
ADC_CALI B_ADDRM address start of milliamp analog input channels

NOTE: This function cannot be run in RAM.
PARAMETER
channel is the analog input channel number (0 to 7) corresponding to ADC_INO-ADC_IN7
opnode is the mode of operation:

SI NGLE—single-ended input line
DI FF—differential input line
mANMP—milliamp input line

channel SI NGLE DI FF mAMP
0 +AINO +AINO -AIN1 +AINO”
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AINS +AIN4
5 +AINS +AINS -AIN4* +AINS
6 +AING +AING -AIN7* +AING
7 +AIN7 +AIN7 -AIN6* +AIN7*

ALLCHAN read all channels for selected opnode

* Not accessible on RCM3600 Prototyping Board.
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gai ncode is the gain code of 0 to 7. The gai ncode parameter is ignored when channel is ALLCHAN.

RETURN VALUE
0 if successful

Voltage Range”

Gain Code
V)
0 0-20
1 0-10
2 0-5
3 0-4
4 0-2.5
5 0-2
6 0-1.25
7 0-1

-1 if address is invalid or out of range.

SEE ALSO

anal nEEW, analnCalib

* Applies to Prototyping Board.

voi d di gConfi g(char statenmask);

Configures channels P100 to P103 on the A/D converter to allow them to be used as digital 1/O via
header JP4 on the RCM3600 Prototyping Board.

Remember to execute the br dI ni t function before calling this function to prevent a runtime error.

PARAMETER

st at emask is a bitwise mask representing JP4 channels 1 to 4. Use logic 0 for inputs and logic 1 for

outputs in these bit positions:

bits 7-5—0
bit 4—JP4:4
bit 3—JP4:3
bit 2—JP4:2
bit 1—JP4:1
bit 0—0
RETURN VALUE
None.

SEE ALSO
di gQut, digln
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void digQut(int channel, int state);

Writes a state to a digital output channel on header JP4 of the RCM3600 Prototyping Board. The PIOOQ to
P103 channels on the A/D converter chip are accessed via header JP4 on the RCM3600 Prototyping
Board.

A runtime error will occur if the br dI ni t function was not executed before calling this function or if
the channel is out of range.

PARAMETERS
channel ischannel 1 to 4 for JP4:1 to JP4:4

st at e isa logic state of O or 1

RETURN VALUE
None.

SEE ALSO
brdinit, digln

int digln(int channel);

Reads the state of a digital input channel on header JP4 of the RCM3600 Prototyping Board. The PIOO0 to
P103 channels on the A/D converter chip are accessed via header JP4 on the RCM3600 Prototyping
Board.

A runtime error will occur if the br dI ni t function was not executed before calling this function or if
the channel is out of range.

PARAMETERS
channel ischannel 1 to 4 for JP4:1 to JP4:4

st at e is a logic state of 0 or 1

RETURN VALUE
None.

SEE ALSO
brdlinit, digCQut
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5.2.3 Digital /O

The RCM3600 was designed to interface with other systems, and so there are no drivers
written specifically for the 1/0. The general Dynamic C read and write functions allow
you to customize the parallel 1/0 to meet your specific needs. For example, use

W Port | ( PEDDR, &PEDDRShadow, 0x00);
to set all the Port E bits as inputs, or use

W Port | (PEDDR, &PEDDRShadow, OxFF);

to set all the Port E bits as outputs.

When using the auxiliary 1/0 bus on the Rabbit 3000 chip, add the line
#define PORTA_LAUX IO  // required to enable auxiliary I/O bus

to the beginning of any programs using the auxiliary 1/0 bus.

The sample programs in the Dynamic C SAMPLES/ RCVB600 folder provide further exam-
ples.
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5.2.4 Serial Communication Drivers

Library files included with Dynamic C provide a full range of serial communications sup-
port. The RS232. LI B library provides a set of circular-buffer-based serial functions. The
PACKET. LI B library provides packet-based serial functions where packets can be delimited
by the 9th bit, by transmission gaps, or with user-defined special characters. Both libraries
provide blocking functions, which do not return until they are finished transmitting or
receiving, and nonblocking functions, which must be called repeatedly until they are fin-
ished, allowing other functions to be performed between calls. For more information, see
the Dynamic C Function Reference Manual and Technical Note TN213, Rabbit Serial
Port Software.
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5.3 Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web
sites

* www.zworld.com/support/

or

» www.rabbitsemiconductor.com/support/

for the latest patches, workarounds, and bug fixes.
5.3.1 Add-On Modules

Dynamic C installations are designed for use with the board they are included with, and
are included at no charge as part of our low-cost kits. Z-World offers add-on Dynamic C
modules including the popular pC/OS-11 real-time operating system, as well as PPP,
Advanced Encryption Standard (AES), and other select libraries.

In addition to the Web-based technical support included at no extra charge, a one-year
telephone-based technical support module is also available for purchase.
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APPENDIX A. RCM3600 SPECIFICATIONS

Appendix A provides the specifications for the RCM3600, and
describes the conformal coating.
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A.l1 Electrical and Mechanical Characteristics
Figure A-1 shows the mechanical dimensions for the RCM3600.
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Figure A-1. RCM3600 Dimensions
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the
RCM3600 in all directions when the RCM3600 is incorporated into an assembly that
includes other printed circuit boards. This “exclusion zone” that you keep free of other
components and boards will allow for sufficient air flow, and will help to minimize any
electrical or electromagnetic interference between adjacent boards. An “exclusion zone”
of 0.08" (2 mm) is recommended below the RCM3600 when the RCM3600 is plugged
into another assembly using the shortest connectors for header J1. Figure A-2 shows this

“exclusion zone.”

| 2.190 |
‘ (55.6)

|0.784
‘ (19.9)

< | 1.310 .
32 (332) Exclusion
S= Zone
s
o
oV owmmmdl, )
‘ ] —
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Figure A-2. RCM3600 “Exclusion Zone”
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Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM3600.

Table A-1. RabbitCore RCM3600 Specifications

Parameter

RCM3600 RCM3610

Microprocessor

Low-EMI Rabbit 3000® at 22.1 MHz

Flash Memory

512K 256K

SRAM

512K 128K

Backup Battery

Connection for user-supplied backup battery
(to support RTC and SRAM)

General-Purpose 1/0

33 parallel digital 1/0 lines:
* 31 configurable 1/0
* 2 fixed outputs

Additional 1/0

Reset

Auxiliary 1/0 Bus

Can be configured for 8 data lines and
5 address lines (shared with parallel 1/0O lines), plus 1/O read/write

Four 3.3 V CMOS-compatible ports configurable as:
¢ 4 asynchronous serial ports (with IrDA) or

Serial Ports

¢ 3 clocked serial ports (SPI) plus 1 HDLC (with IrDA) or

¢ 1 clocked serial port (SPI) plus 2 HDLC serial ports (with IrDA)
Serial Rate Maximum asynchronous baud rate = CLK/8

Slave Interface

A slave port allows the RCM3600 to be used as an intelligent peripheral
device slaved to a master processor, which may either be another Rabbit
3000 or any other type of processor

Real-Time Clock

Yes

Timers

Ten 8-bit timers (6 cascadable), one 10-bit timer with 2 match registers

Watchdog/Supervisor

Yes

Pulse-Width Modulators

4 PWM output channels with 10-bit free-running counter
and priority interrupts

Input Capture/
Quadrature Decoder

2-channel input capture can be used to time input signals from various

port pins

¢ 1 quadrature decoder unit accepts inputs from external incremental
encoder modules or

¢ 1 quadrature decoder unit shared with 2 PWM channels

Power 4.00-12.6 V DC
60 MA @ 22.1 MHz, 5V; 38 mA @ 11.06 MHz, 5V
Operating Temperature —40°C to +85°C

Humidity 5% to 95%, noncondensing
Connectors One 2 x 20, 0.1" pitch
Board Size 1.23" x 211" x 0.62

(31 mm x 54 mm x 16 mm)
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A.1.1 Headers

The RCM3600 uses one headers at J1 for physical connection to other boards. J1 is a
2 x 20 SMT header with a 0.1" pin spacing.

Figure A-3 shows the layout of another board for the RCM3600 to be plugged into. These
values are relative to the designated fiducial (reference point).

1.629
(41.4)
0.597
J1 | (15.2)
1.100 * ................. _L N
(27.9) |
' 1.519 '
| (38.6) |
RCM3600 Footprint

Figure A-3. User Board Footprint for RCM3600
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A.2 Bus Loading

You must pay careful attention to bus loading when designing an interface to the
RCM3600. This section provides bus loading information for external devices.

Table A-2 lists the capacitance for the various RCM3600 1/O ports.

Table A-2. Capacitance of Rabbit 3000 I/O Ports

Input Output
I/O Ports Capacitance Capacitance
(pF) (pF)
Parallel Ports Ato G 12 14

Table A-3 lists the external capacitive bus loading for the various RCM3600 output ports.

Be sure to add the loads for the devices you are using in your custom system and verify
that they do not exceed the values in Table A-3.

Table A-3. External Capacitive Bus Loading -40°C to +85°C

St Ba Clock Speed Maximum External
P (MHz) | Capacitive Loading (pF)

All 1/0 lines with clock
doubler enabled 221 100
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Figure A-4 shows a typical timing diagram for the Rabbit 3000 microprocessor external
memory read and write cycles.

NOTE: /IOCSx can be programmed to be active low (default) or active high.

External I/O Read (no extra wait states)

1 | Tw———s—— T2 |
CLK —
A[15:0] X valid X
7 Tadr
/CSx | | \__
1 Tcsx Tesx <7
/I0CSx K -
1 Tiocsx Tiocsx|<]
/IORD -
TiorD TiorRD[<]
/BUFEN -
“1TBUFEN TBUFﬁN‘_’
setup, |
D[7:0] < X _valid -
| Thold <"
External I/O Write (no extra wait states)
k—T1 | Tw—] T2 ——)
o | | |
A[15:01 — X valid : C
7 Tadr ‘
\
ICSx | 1 \ N
I Tcsx } Tesx[7
/I0CSx ! ) &
1 Tiocsx { Tiocsx[<
/IOWR ‘ R
Tiowr TiowR[<™]
/BUFEN 8
~1TBUFEN TBUFEN]
D[7:0] valid —
TbHzv ‘ TovHz <

Figure A-4. 1/0 Read and Write Cycles—No Extra Wait States
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Table A-4 lists the delays in gross memory access time for several values of Vpp.

Table A-4. Data and Clock Delays VIN £10%, Temp, -40°C—+85°C (maximum)

Clock to Address Output Delay Spectrum Spreader Delay
(ns) Data Setup (ns)
VIN Time Delay
30 oF 60 0F 90 oF (ns) Normal Strong
k k k no dbl/dbl | no dbl/dbl
50V 6 8 11 1 3/4.5 4.5/9

The measurements are taken at the 50% points under the following conditions.

* T=-40°Cto 85°C, V =Vpp +10%

 Internal clock to nonloaded CLK pin delay <1 ns @ 85°C/3.0 V

The clock to address output delays are similar, and apply to the following delays.
* T,gr the clock to address delay

* Ty the clock to memory chip select delay

* Tiocsx the clock to 1/0 chip select delay

* Tiorp, the clock to 1/0 read strobe delay

* Tiowr the clock to 1/0 write strobe delay

* Tguren, the clock to 1/0 buffer enable delay

The data setup time delays are similar for both Tgey,p and Tpoyg.

When the spectrum spreader is enabled with the clock doubler, every other clock cycle is
shortened (sometimes lengthened) by a maximum amount given in the table above. The
shortening takes place by shortening the high part of the clock. If the doubler is not
enabled, then every clock is shortened during the low part of the clock period. The maxi-
mum shortening for a pair of clocks combined is shown in the table.

Technical Note TN227, Interfacing External 1/0 with Rabbit 2000/3000 Designs, con-
tains suggestions for interfacing 1/0 devices to the Rabbit 3000 microprocessors.
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A.3 Rabbit 3000 DC Characteristics

Table A-5. Rabbit 3000 Absolute Maximum Ratings

Symbol Parameter Maximum Rating
Ta Operating Temperature -55° to +85°C
Ts Storage Temperature -65° to +150°C

Maximum Input \oltage:

¢ Oscillator Buffer Input Vpp +05V

* 5-V-tolerant I/O 55V
Vpp | Maximum Operating Voltage 3.6V

Stresses beyond those listed in Table A-5 may cause permanent damage. The ratings are
stress ratings only, and functional operation of the Rabbit 3000 chip at these or any other
conditions beyond those indicated in this section is not implied. Exposure to the absolute
maximum rating conditions for extended periods may affect the reliability of the Rabbit
3000 chip.

Table A-6 outlines the DC characteristics for the Rabbit 3000 at 3.3 V over the recom-
mended operating temperature range from T, = -55°C to +85°C, Vpp = 3.0V t0 3.6 V.

Table A-6. 3.3 Volt DC Characteristics

Symbol Parameter Test Conditions Min | Typ | Max | Units
Vpp | Supply Voltage 3.0 3.3 3.6 \%
Viy | High-Level Input Voltage 2.0 \Y
VL Low-Level Input Voltage 0.8 \Y

loy = 6.8 MA, 0.7 x
V High-Level Output Voltage . \%
on J P % | Vpp = Vpp (min) Vbp
Vv Low-Level Output Volt lo =6.8mA, 04 |V
ow-Level Output Voltage . .
ot P % | Vpp = Vpp (min)
| High-Level Input Current | ViN = VDD 10 A
'H | (@bsolute worst case, all buffers) | Vpp = Vpp (Mmax) H
| Low-Level Input Current | ViN = Vss, 10 A
IL (absolute worst case, all buffers) | Vpp = Vpp (max) H
loz ngtEL'tT:pueﬁZﬂf oo Vin = Voo o Vss -10 10 | pA
(absolute worst case, all buffers) Voo = Vpp (max), no pull-up
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A.4 1/0O Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit 1/0 buffers are capable of sourcing and sinking
6.8 mA of current per pin at full AC switching speed. Full AC switching assumes a

22.1 MHz CPU clock and capacitive loading on address and data lines of less than 100 pF
per pin. The absolute maximum operating voltage on all 1/O is 5.5 V.

Table A-7 shows the AC and DC output drive limits of the parallel 1/0 buffers when the

Rabbit 3000 is used in the RCM3600.

Table A-7. I/O Buffer Sourcing and Sinking Capability

Pin Name

Output Drive (Full AC Switching)

Sourcing/Sinking Limits

(mA)

Sourcing

Sinking

All data, address, and 1/0
lines with clock doubler
enabled

6.8

6.8

Under certain conditions, you can exceed the limits outlined in Table A-7. See the Rabbit
3000 Microprocessor User’s Manual for additional information.
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A.5 Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator have had the Dow Corning
silicone-based 1-2620 conformal coating applied. The conformally coated area is shown
in Figure A-5. The conformal coating protects these high-impedance circuits from the
effects of moisture and contaminants over time.

Conformally coated
area

Figure A-5. RCM3600 Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering
procedures for surface-mounted components. A new conformal coating should then be
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note 303, Con-
formal Coatings.
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A.6 Jumper Configurations

Figure A-6 shows the header locations used to configure the various RCM3600 options
via jumpers.

Top Side

JP2 JP1 JP3

Figure A-6. Location of RCM3600 Configurable Positions

Table A-8 lists the configuration options.

Table A-8. RCM3600 Jumper Configurations

Header Description Pins Connected eteiels
Default

1-2 | Normal Mode X
JP1 Flash Memory Bank Select

2-3 |Bank Mode

1-2 | 128K-256K RCM3610
JP2 | SRAM Size

2-3 |512K RCM3600

1-2 | 256K RCM3610
JP3 Flash Memory Size

2-3 |512K RCM3600

NOTE: The jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX B. PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board.
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B.1 Introduction

The Prototyping Board included in the Development Kit makes it easy to connect an
RCM3600 module to a power supply and a PC workstation for development. It also pro-
vides some basic 1/0O peripherals (RS-232, RS-485, an IrDA transceiver, LEDs, and
switches), as well as a prototyping area for more advanced hardware development.

For the most basic level of evaluation and development, the Prototyping Board can be
used without modification.

As you progress to more sophisticated experimentation and hardware development, modi-
fications and additions can be made to the board without modifying or damaging the
RCM3600 module itself.

The Prototyping Board is shown below in Figure B-1, with its main features identified.
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Figure B-1. Prototyping Board
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B.1.1 Prototyping Board Features

Power Connection—A 3-pin header is provided for connection to the power supply.

Note that the 3-pin header is symmetrical, with both outer pins connected to ground and
the center pin connected to the raw DCIN input. The cable of the AC adapter provided
with the North American version of the Development Kit ends in a plug that connects

to the power-supply header, and can be connected to the 3-pin header in either orienta-
tion. A similar header plug leading to bare leads is provided for overseas customers.

Users providing their own power supply should ensure that it delivers 7.5-30 V DC at
500 mA. The voltage regulators will get warm while in use.

Regulated Power Supply—The raw DC voltage provided at the POWER IN jack is
routed to a 5 V switching voltage regulator, then to a separate 3.3 V linear regulator.
The regulators provide stable power to the RCM3600 module and the Prototyping
Board.

Power LED—The power LED lights whenever power is connected to the Prototyping
Board.

Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM3600’s /RESET _IN pin. Pressing the switch forces a hardware reset of the system.

I/O Switches and LEDs—Two momentary-contact, normally open switches are con-
nected to the PF4 and PB7 pins of the RCM3600 module and may be read as inputs by
sample applications.

Two LEDs are connected to the PF6 and PF7 pins of the RCM3600 module, and may
be driven as output indicators by sample applications.

Prototyping Area—A generous prototyping area has been provided for the installation
of through-hole components. +3.3 V, +5 V, and Ground buses run at both edges of this
area. Several areas for surface-mount devices are also available. (Note that there are
SMT device pads on both top and bottom of the Prototyping Board.) Each SMT pad is
connected to a hole designed to accept a 30 AWG solid wire.

LCD/Keypad Module—Z-World’s LCD/keypad module may be plugged in directly to
headers LCD1JA, LCD1JB, and LCD1JC. The signals on headers LCD1JB and
LCD1JC will be available only if the LCD/keypad module is plugged in to header
LCD1JA. Appendix C provides complete information for mounting and using the
LCD/keypad module.

Module Extension Headers—The complete non-analog pin set of the RCM3600
module is duplicated at header J3. Developers can solder wires directly into the appro-
priate holes, or, for more flexible development, a 2 x 20 header strip with a 0.1" pitch
can be soldered into place. See Figure B-4 for the header pinouts.

Analog I/O Shrouded Headers—The complete analog pin set of the RCM3600
Prototyping Board is available on shrouded headers J8 and J9. See Figure B-4 for the
header pinouts.
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RS-232—Three 3-wire serial ports or one 5-wire RS-232 serial port and one 3-wire
serial port are available on the Prototyping Board at header J2. A jumper on header JP2
is used to select the drivers for Serial Port E, which can be set either as a 3-wire RS-232
serial port or as an RS-485 serial port. Serial Ports C and D are not available while the
IrDA transceiver is in use.

A 10-pin 0.1-inch spacing header strip is installed at J2 allows you to connect a ribbon
cable that leads to a standard DE-9 serial connector.

RS-485—O0ne RS-485 serial port is available on the Prototyping Board at shrouded
header J1. A 3-pin shrouded header is installed at J1. A jumper on header JP2 enables
the RS-485 output for Serial Port E.

IrDA—An infrared transceiver is included on the Prototyping Board, and is capable of
handling link distances up to 1.5 m. The IrDA uses Serial Port F—Serial Ports C and D
are unavailable while Serial Port F is in use.
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B.2 Mechanical Dimensions and Layout

Figure B-2 shows the mechanical dimensions and layout for the RCM3600 Prototyping Board.
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Figure B-2. Prototyping Board Dimensions
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Table B-1 lists the electrical, mechanical, and environmental specifications for the Proto-
typing Board.

Table B-1. Prototyping Board Specifications

Parameter Specification
Board Size 4.50" x 6.50" x 0.75" (114 mm x 165 mm x 19 mm)
Operating Temperature —20°C to +60°C
Humidity 5% to 95%, noncondensing
Input Voltage 75Vto30VDC
Maximum Current Draw 800 mA max. for +3.3 V supply,

(including user-added circuits) | 1 A total +3.3 V and +5 V combined

8-channel ADS7870 with programmable gain configurable for

11-bit single-ended, 12-bit differential, and 4-20 mA inputs

A/D Converter * Input impedance 6-7 MQ

« AJD conversion time (including 120 ps raw count and
Dynamic C) 180 ps

IrDA Transceiver HSDL-3602, link distances up to 1.5 m

2.5" x 3" (64 mm x 76 mm) throughhole, 0.1" spacing,

Prototyping Area additional space for SMT components

Standoffs/Spacers 5, accept 4-40 x 1/2 screws

B.3 Power Supply

The RCM3600 requires a regulated 4.0 V to 12.6 VV DC power source to operate. Depend-
ing on the amount of current required by the application, different regulators can be used
to supply this voltage.

The Prototyping Board has an onboard +5 V switching power regulator from which a
+3.3 V linear regulator draws its supply. Thus both +5 V and +3.3 V are available on the
Prototyping Board.

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2
as shown in Figure B-3.
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Figure B-3. Prototyping Board Power Supply
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B.4 Using the Prototyping Board
The Prototyping Board is actually both a demonstration board and a prototyping board. As

a demonstration board, it can be used to demonstrate the functionality of the RCM3600

right out of the box without any modifications.

The Prototyping Board pinouts are shown in Figure B-4.
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The Prototyping Board comes with the basic components necessary to demonstrate the
operation of the RCM3600. Two LEDs (DS1 and DS2) are connected to PF6 and PF7, and
two switches (S1 and S2) are connected to PF4 and PB7 to demonstrate the interface to the
Rabbit 3000 microprocessor. Reset switch S3 is the hardware reset for the RCM3600.

The Prototyping Board provides the user with RCM3600 connection points brought out con-
veniently to labeled points at header J3 on the Prototyping Board. Although header J3 is
unstuffed, a 2 x 20 header is included in the bag of parts. RS-485 signals are available on
shrouded header J1, and RS-232 signals (Serial Ports C, D, and E) are available on header J2.
A header strip at J2 allows you to connect a ribbon cable. A shrouded header connector and
wiring harness are included with the Development Kit parts to help you access the RS-485 sig-
nals on shrouded header J1.

There is a 2.5" x 3" through-hole prototyping space available on the Prototyping Board.
The holes in the prototyping area are spaced at 0.1" (2.5 mm). +3.3 V, +5 V, and GND traces
run along both edges of the prototyping area for easy access. Small to medium circuits can
be prototyped using point-to-point wiring with 20 to 30 AWG wire between the prototyping
area, the +3.3 'V, +5 V, and GND traces, and the surrounding area where surface-mount
components may be installed. Small holes are provided around the surface-mounted com-
ponents that may be installed around the prototyping area.

B.4.1 Adding Other Components

There are two sets of pads for 28-pin devices that can be used for surface-mount prototyp-
ing SOIC devices. (Although the adjacent sets of pads could accommodate up to a 56-pin
device, they do not allow for the overlap between two 28-pin devices.) There are also pads
that can be used for SMT resistors and capacitors in an 0805 SMT package. Each compo-
nent has every one of its pin pads connected to a hole in which a 30 AWG wire can be sol-
dered (standard wire wrap wire can be soldered in for point-to-point wiring on the
Prototyping Board). Because the traces are very thin, carefully determine which set of
holes is connected to which surface-mount pad.
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B.4.2 Analog Features

The RCM3600 Prototyping Board has an onboard ADS7870 A/D converter to demon-
strate the interface capabilities of the Rabbit 3000. The A/D converter multiplexes con-
verted signals from eight single-ended or three differential inputs to alternate Serial Port B
on the Rabbit 3000 (Parallel Port pins PD4 and PD5).

B.4.2.1 A/D Converter Inputs

Figure B-5 shows a pair of A/D converter input circuits. The resistors form an approx.
10:1 attenuator, and the capacitor filters noise pulses from the A/D converter input.

+y User Circuits

—— > VREF

ADC_INO

ADC

ADC_IN1
AAY

AGND

Figure B-5. A/D Converter Inputs

The A/D converter chip can make either single-ended or differential measurements
depending on the value of the opnode parameter in the software function call. Adjacent
A/D converter inputs can be paired to make differential measurements. The default setup
on the Prototyping Board is to measure only positive voltages for the ranges listed in
Table B-2.
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Table B-2. Positive A/D Converter Input Voltage Ranges
Min. X;))Itage Max.(\\//t;ltage An;::il:er Y e @i
0.0 +20.0 1 10

0.0 +10.0 2 5
0.0 +5.0 4 25
0.0 +4.0 5 2.0
0.0 +2.5 8 1.25
0.0 +2.0 10 1.0
0.0 +1.25 16 0.625
0.0 +1.0 20 0.500

Other possible ranges are possible by physically changing the resistor values that make up
the attenuator circuit.

It is also possible to read a negative voltage on ADC_INO to ADC_IN5 by moving the
jumper (see Figure B-5) on header JP7, JP6, or JP5 associated with the A/D converter
input from analog ground to VREF, the reference voltage generated and buffered by the
A/D converter. Adjacent input channels are paired so that moving a particular jumper
changes both of the paired channels. At the present time Z-World does not offer the soft-
ware drivers to work with single-ended negative voltages, but the differential mode
described below may be used to measure negative voltages.

NOTE: THERM_IN7 was configured to illustrate the use of a thermistor with the sample
program, and so is not available for use as a differential input. There is also no resistor
attenuator for THERM _IN7, so its input voltage range is limited.

Differential measurements require two channels. As the name differential implies, the dif-
ference in voltage between the two adjacent channels is measured rather than the differ-
ence between the input and analog ground. Voltage measurements taken in differential
mode have a resolution of 12 bits, with the 12th bit indicating whether the difference is
positive or negative.

The A/D converter chip can only accept positive voltages. Both differential inputs must be
referenced to analog ground, and both inputs must be positive with respect to analog
ground. Table B-3 provides the differential voltage ranges for this setup.

74 RabbitCore RCM3600



Table B-3. Differential Voltage Ranges

Min. Differential | Max. Differential Amplifier
Voltage Voltage : mV per Count

) ) Gain

0 +20.0 x1 10
0 +10.0 X2 5

0 +5.0 x4 25
0 +4.0 x5 2.0
0 2.5 x8 1.25
0 +2.0 x10 1.00
0 +1.25 x16 0.625
0 +1.0 x20 0.500

The A/D converter inputs can also be used with 4-20 mA current sources by measuring the
resulting analog voltage drop across 249 Q 1% precision resistors placed between the ana-
log input and analog ground for ADC_IN3 to ADC_ING6. Be sure to reconfigure the
jumper positions on header JP8 as shown in Section B.5 using the slip-on jumpers
included with the spare parts in the Development Kit.

B.4.2.2 Thermistor Input

Analog input THERM_IN7 on the Prototyping Board was designed specifically for use
with a thermistor in conjunction with the THERM STOR. C sample program, which demon-
strates how to use analog input THERM_IN7 to calculate temperature for display to the
Dynamic C STDIO window. The sample program is targeted specifically for the thermistor
included with the Development Kit with Ry @ 25°C = 3 kQ and [3 25/85 = 3965. Be sure

to use the applicable Ry and 3 values for your thermistor if you use another thermistor.
Install the thermistor at location J7, which is shown in Figure B-4.

VREF

1kQ

Thermistor |7

THERM_IN7
VA ADC
ANALOG_GND
L

Figure B-6. Prototyping Board Thermistor Input
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B.4.2.3 Other A/D Converter Features

The A/D converter’s internal reference voltage is software-configurable for 1.15V, 2.048 V,
or 2.5 V. The scaling circuitry on the Prototyping Board and the sample programs are opti-
mized for an internal reference voltage of 2.048 V. This internal reference voltage is avail-
able on pin 3 of shrouded header J8 as VREF, and allows you to convert analog input
voltages that are negative with respect to analog ground.

NOTE: The amplifier inside the A/D converter’s internal voltage reference circuit has a
very limited output-current capability. The internal buffer can source up to 20 mA and
sink only up to 20 pA. A separate buffer amplifier at U7 supplies the load current.

The A/D converter’s CONVERT pin is available on pin 2 of shrouded header J8, and can
be used as a hardware means of forcing the A/D converter to start a conversion cycle. The

CONVERT signal is an edge-triggered event and has a hold time of two CCLK periods for
debounce.

A conversion is started by an active (rising) edge on the CONVERT pin. The CONVERT
pin must stay low for at least two CCLK periods before going high for at least two CCLK
periods. Figure B-7 shows the timing of a conversion start. The double falling arrow on
CCLK indicates the actual start of the conversion cycle.

Conversion starts

¢

BUSY /
CONV / \

Figure B-7. Timing Diagram for Conversion Start Using CONVERT Pin
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B.4.2.4 A/D Converter Calibration

To get the best results from the A/D converter, it is necessary to calibrate each mode (sin-
gle-ended, differential, and current) for each of its gains. It is imperative that you calibrate
each of the A/D converter inputs in the same manner as they are to be used in the applica-
tion. For example, if you will be performing floating differential measurements or differ-
ential measurements using a common analog ground, then calibrate the A/D converter in
the corresponding manner. The calibration must be done with the attenuator reference
selection jumper in the desired position (see Figure B-5). If a calibration is performed and
the jumper is subsequently moved, the corresponding input(s) must be recalibrated. The
calibration table in software only holds calibration constants based on mode, channel, and
gain. Other factors affecting the calibration must be taken into account by calibrating
using the same mode and gain setup as in the intended use.

Sample programs are provided to illustrate how to read and calibrate the various A/D
inputs for the three operating modes.

Mode Read Calibrate
Single-Ended, one channel — AD CALSE CH. C
Single-Ended, all channels AD RDSE ALL.C AD CALSE ALL.C
Milliamp, one channel AD RDVA CH. C AD CALNA CH. C
Differential, analog ground AD RDDI FF_CH. C AD CALDI FF_CH. C

These sample programs are found in the ADC subdirectory in SAMPLES\ RCM3600. See
Section 3.2.2 for more information on these sample programs and how to use them.
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B.4.3 Serial Communication

The RCM3600 Prototyping Board allows you to access five of the serial ports from the

RCM3600 module. Table B-4 summarizes the configuration options.

Table B-4. RCM3600 Prototyping Board Serial Port Configurations

Configured via

Serial Port Signal Header Header Default Use Alternate Use
J2 JP2 RS-232 —
D J2 JP2 RS-232 —
J1,J2 JP1, JP2 RS-485 (J1) RS-232 (J2)

Serial Port E is configured in hardware for RS-232 or RS-485 via jumpers on header JP2
as shown in Section B.5. Serial Port F is configured in software for the IrDA transceiver in
lieu of Serial Ports C and D.
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B.4.3.1 RS-232

RS-232 serial communication on the RCM3600 Prototyping Board is supported by an
RS-232 transceiver installed at U4. This transceiver provides the voltage output, slew rate,
and input voltage immunity required to meet the RS-232 serial communication protocol.
Basically, the chip translates the Rabbit 3000’s signals to RS-232 signal levels. Note that
the polarity is reversed in an RS-232 circuit so that a +5 V output becomes approximately
-10 V and 0 V is output as +10 V. The RS-232 transceiver also provides the proper line
loading for reliable communication.

RS-232 can be used effectively at the RCM3600 module’s maximum baud rate for distances
of upto 15 m.

RS-232 flow control on an RS-232 port is initiated in software using the ser Xf | owcon-
t r ol On function call from RS232. LI B, where X is the serial port (C or D). The locations
of the flow control lines are specified using a set of five macros.

SERX_RTS PORT—Data register for the parallel port that the RTS line is on (e.g., PCDR).

SERA RTS SHADOW-—Shadow register for the RTS line's parallel port (e.g., PCDRShadow).
SERA RTS_ BI T—The bit number for the RTS line.

SERA CTS_PORT—Data register for the parallel port that the CTS line is on (e.g., PCDRShadow).
SERA CTS_BI T—The bit number for the CTS line.

Standard 3-wire RS-232 communication using Serial Ports C and D is illustrated in the
following sample code.

#define ClI NBUFSI ZE 15
#def i ne COUTBUFSI ZE 15

#define DI NBUFSI ZE 15
#def i ne DOUTBUFSI ZE 15

#defi ne MYBAUD 115200
#endi f

mai n() {
ser Copen( _MYBAUD) ;
ser Dopen( _MYBAUD) ;
ser Cw Fl ush();
ser CrdFl ush();
ser Dw Fl ush();
ser DrdFl ush();
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B.4.3.2 RS-485

The RCM3600 Prototyping Board has one RS-485 serial channel, which is connected to
the Rabbit 3000 Serial Port E through an RS-485 transceiver. The half-duplex communi-
cation uses an output from PF5 on the Rabbit 3000 to control the transmit enable on the
communication line. Using this scheme a strict master/slave relationship must exist
between devices to insure that no two devices attempt to drive the bus simultaneously.

Serial Port E is configured in software for RS-485 as follows.

#defi ne ser485o0pen ser Eopen
#define ser485cl ose serEcl ose
#define ser 485w Fl ush ser Ewr Fl ush
#define ser485rdFl ush ser ErdFl ush
#define ser485putc serEputc
#define ser485getc serEgetc

#define EI NBUFSI ZE 15
#def i ne EQUTBUFSI ZE 15

The configuration shown above is based on circular buffers. RS-485 configuration may
also be done using functions from the PACKET. LI B library.

The RCM3600 Prototyping Boards with RCM3600 modules installed can be used in an
RS-485 multidrop network spanning up to 1200 m (4000 ft), and there can be as many as
32 attached devices. Connect the 485+ to 485+ and 485— to 485- using single twisted-pair
wires as shown in Figure B-8. Note that a common ground is recommended.

[m)]
zZz
]

RS-485—
RS485+
GND [—
RS-485—
RS485+
RS-485- [~
RS485+ |[—
GND |—

Figure B-8. RCM3600 Multidrop Network
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The RCM3600 Prototyping Board comes with a 220 Q termination resistor and two 681 Q
bias resistors installed and enabled with jumpers across pins 1-2 and 5-6 on header JP1,
as shown in Figure B-9.
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Figure B-9. RS-485 Termination and Bias Resistors

For best performance, the termination resistors in a multidrop network should be enabled
only on the end nodes of the network, but not on the intervening nodes. Jumpers on boards
whose termination resistors are not enabled may be stored across pins 1-3 and 4-6 of
header JP1.

B.4.4 Other Prototyping Board Modules

An optional LCD/keypad module is available that can be mounted on the Prototyping
Board. The signals on headers LCD1JB and LCD1JC will be available only if the
LCD/keypad module is installed. Refer to Appendix C, “LCD/Keypad Module,” for
complete information.

CAUTION: Pin PB7 is connected as both switch S2 and as an external 1/0 bus on the
Prototyping Board. Do not use S2 when the LCD/keypad module is installed.
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B.5 RCM3600 Prototyping Board Jumper Configurations

Figure B-10 shows the header locations used to configure the various RCM3600 Prototyp-
ing Board options via jumpers.

JP1

elele)
JP2

JP4

Jbg JP5 JP6 JP7

( Battery )

Figure B-10. Location of RCM3600 Configurable Positions
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Table B-5 lists the configuration options using jumpers.

Table B-5. RCM3600 Jumper Configurations

Header Description Pins Connected Factory
Default
1-2 | Bias and termination resistors X
5-6 | connected
P1 RS-485 Bias and Termination
Resistors 1-3 Bias and termination resistors not
46 connected (parking position for
jumpers)
S Rs23
JP2 RS-232/RS-485 on Serial Port E
3-5
46 RS-485 X
1 [PIOC_O n.c.
2 |PIO_1 n.c.
JP4 | A/D Converter Outputs
3 |PIO_2 n.c.
4 |PIO_3 n.c.
1-2 | Tied to VREF
JP5 | ADC_IN4-ADC_IN5
2-3 | Tied to analog ground X
1-2 | Tied to VREF
JP6 | ADC_IN2-ADC_IN3
2-3 | Tied to analog ground X
1-2 | Tied to VREF
JP7 | ADC_INO-ADC_IN1
2-3 | Tied to analog ground X
1-2 | Connect for 4-20 mA option on ADC_IN3 n.c.
Analog Voltage/4-20 mA 3-4 | Connect for 4-20 mA option on ADC_IN4 n.c.
JP8 .
Options 5-6 | Connect for 4-20mAoptionon ADC_IN5 | n.c.
7-8 | Connect for 4-20 mA option on ADC_IN6 n.c.
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APPENDIX C. LCD/KEYPAD MODULE

An optional LCD/keypad is available for the Prototyping Board.
Appendix C describes the LCD/keypad and provides the soft-
ware APIs to make full use of the LCD/keypad.

C.1 Specifications

The LCD/keypad module comes with or without a panel-mounted NEMA 4 water-resistant
bezel as shown in Figure C-1.

LCD/Keypad Modules

00000000 e0oc0o0o0o0

Figure C-1. LCD/Keypad Modules Versions

Both versions can mount directly on the Prototyping Board, and the version with a bezel
can be installed at a remote location up to 60 cm (24") away. Contact your Z-World sales
representative or your authorized Z-World distributor for further assistance in purchasing
an LCD/keypad module.

Mounting hardware and a 60 cm (24") extension cable are also available for the
LCD/keypad module through your Z-World sales representative or authorized distributor.
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Table C-1 lists the electrical, mechanical, and environmental specifications for the

LCD/keypad module.

Table C-1. LCD/Keypad Specifications

Parameter Specification
. 2.60" x 3.00" x 0.75"
Board Size (66 mm x 76 mm x 19 mm)
Temperature Operating Range: 0°C to +50°C

Storage Range: —40°C to +85°C

Humidity

5% to 95%, noncondensing

Power Consumption

1.5 W maximum”

Connections

Connects to high-rise header sockets on the Prototyping Board

LCD Panel Size

122 x 32 graphic display

Keypad

7-key keypad

LEDs

Seven user-programmable LEDs

* The backlight adds approximately 650 mW to the power consumption.
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C.2 Jumper-Selectable Voltage Settings for All Boards

Before using the LCD/keypad module, set the voltage for 3.3 V by setting the jumper
across pins 3—4 on header J5 as shown in Figure C-2.

LCD/Keypad Module Jumper Configurations

Header Description Co:ri\:?:ted lI:Jae?ac::I!t,
28V 12 X
I5 33V 34
5V nc.

OoOE OE OE OE On

e B T T B B ©
= | ] ocd

x o4 § a6 JQ
o 4

Part No. 101-0541

OTHER)LP3500|
3.3V|2.8V

DISPLAY
BOARD

O

Figure C-2. LCD/Keypad Module Voltage Settings

NOTE: Older LCD/keypad modules that do not have a header at J5 are limited to operate
only at 5V, and will not work with the RCM3600 Prototyping Board. The older
LCD/keypad modules are no longer being sold.
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C.3 Keypad Labeling

The keypad may be labeled according to your needs. A template is provided in Figure C-3
to allow you to design your own keypad label insert.

(28)

Figure C-3. Keypad Template

To replace the keypad legend, remove the old legend and insert your new legend prepared
according to the template in Figure C-3. The keypad legend is located under the blue key-
pad matte, and is accessible from the left only as shown in Figure C-4.

Keypad label is located

under the blue keypad matte. O CJeeICICle]@) O

<JoRvl»
B00

Figure C-4. Removing and Inserting Keypad Label

)

The sample program KEYBASI C. Cin the 122x32_1x7 folder in SAMPLES\ LCD_KEYPAD
shows how to reconfigure the keypad for different applications.
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C.4 Header Pinouts
Figure C-5 shows the pinouts for the LCD/keypad module.

J1

/ICS |v o|/RES

DB7B |0 o | DB6B
+5BKLT (o m| VCC

DB5B | o o | DB4B
DB3B |o o | DB2B
DB1B |o o | DBOB
AOB [0 o|A1B

A2B [0 o|A3B

GND |o o | GND
GND |o o| LED7
LED6 |o o | LED5S
LED4 |o o | LED3
LED2 |o o | LED1

GND
DB6B
DB4B
DB2B
DBOB
AOB |Z ©| A1B

J3 J2

A2B |- B | A3B
PE7 |© = |/RES

GND | o |GND
+5BKLT |C W |VCC

GND | = ©|LED7
LED6 | & O |LED5S
LED4 |o O |LED3

LED2 | o o |LED1

GND |o ©
DB7B |0 ©
DB5B |0 O
DB3B |0 ©
DB1B |0 ©

Figure C-5. LCD/Keypad Module Pinouts

C.4.1 1/O Address Assignments

The LCD and keypad on the LCD/keypad module are addressed by the /CS strobe as
explained in Table C-2.

Table C-2. LCD/Keypad Module Address Assignment

Address Function
0xE000 Device select base address (/CS)
OXExx0-0xExx7 LCD control
OXExx8 LED enable
OXExx9 Not used
OXExxA 7-key keypad
OXExxB (bits 0-6) 7-LED driver
OxExxB (bit 7) LCD backlight on/off
OXExxC-ExxF Not used
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C.5 Install Connectors on Prototyping Board

Before you can use the LCD/keypad module with the RCM3600 Prototyping Board, you
will need to install connectors to attach the LCD/keypad module to the RCM3600 Proto-
typing Board. These connectors are included with the RCM3600 Development Kit.

First solder the 2 x 13 connector to location LCD1JA on the RCM3600 Prototyping Board
as shown in Figure C-6.

 If you plan to bezel-mount the LCD/keypad module, continue with the bezel-mounting
instructions in Section C.7, “Bezel-Mount Installation.”

» If you plan to mount the LCD/keypad module directly on the RCM3600 Prototyping
Board, solder two additional 2 x 7 connectors at locations LCD1JB and LCD1JC on the
RCM3600 Prototyping Board. Section C.6, “Mounting LCD/Keypad Module on the
Prototyping Board,” explains how to mount the LCD/keypad module on the RCM3600
Prototyping Board.

RXC TXC RXE

ol o U 5 [ 1
2 2 15 D1
Yo o000 o0
2
“
12
+
o 1

mo0000

YOOO00000!

0.010,0700;

SC
X

c27[ILT|
R2s([TT]! DDDC?B

SOOC
,0.,0.0.0.0,

OQ0Q00

X

SC
X

Q0000

X

'ROTOTYPING BOARD
za
X

v
OQ0C

RCM36/37XX SERIES

X

Figure C-6. Solder Connectors to RC3700 Prototyping Board
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C.6 Mounting LCD/Keypad Module on the Prototyping Board

Install the LCD/keypad module on header sockets LCD1JA, LCD1JB, and LCD1JC of the
Prototyping Board as shown in Figure C-7. Be careful to align the pins over the headers,
and do not bend them as you press down to mate the LCD/keypad module with the Proto-
typing Board.

RCTXCRAE

uxi

:
;

0000000000000

b ot o roa
1 0
SN LTI css

RCM36/37XX SERIES.
ROTOTYPING BOARD.

)

0000000000000 000000000000000Q!
0000000000000 0000000000000000
OOOOO000000000000000000000008

0000000000000,
0000000000000

0000000000000
0000000000000
0000000000000
0000000000000
0000000000000
0000000000000
0000000000000
0000000000000
0000000000000

Figure C-7. Install LCD/Keypad Module on Prototyping Board
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C.7 Bezel-Mount Installation

This section describes and illustrates how to bezel-mount the LCD/keypad module
designed for remote installation. Follow these steps for bezel-mount installation.

1. Cut mounting holes in the mounting panel in accordance with the recommended dimen-
sions in Figure C-8, then use the bezel faceplate to mount the LCD/keypad module onto

the panel.

\‘ ‘/
AN /
AN s
AN /
AN s
AN /
AN Vi
AN /
AN ,
AN ,’
AN s
cuTouT 83
e
// \
s AN
// \
Vi AN
// \
s AN
// \
s AN
// \
s AN
//‘ \
[ AT — — o+
< 0.230 cﬂog
(5.8) o=
2.870 |
(72.9)
3.100
(78.8)

Figure C-8. Recommended Cutout Dimensions

2. Carefully “drop in” the LCD/keypad module with the bezel and gasket attached.
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3. Fasten the unit with the four 4-40 screws and washers included with the LCD/keypad
module. If your panel is thick, use a 4-40 screw that is approximately 3/16" (5 mm)
longer than the thickness of the panel.

/7 Bezel/Gasket

w R W

Om Om OEN ON ON Om Om
R2 ORI Re_ RS R R me
FCUEMI20D 200 200 200 2Eg

Figure C-9. LCD/Keypad Module Mounted in Panel (rear view)

Carefully tighten the screws until the gasket is compressed and the plastic bezel face-
plate is touching the panel.

Do not tighten each screw fully before moving on to the next screw. Apply only one or
two turns to each screw in sequence until all are tightened manually as far as they can
be so that the gasket is compressed and the plastic bezel faceplate is touching the panel.

User’s Manual 93



C.7.1 Connect the LCD/Keypad Module to Your Prototyping Board

The LCD/keypad module can be located as far as 2 ft. (60 cm) away from the RCM3600
Prototyping Board, and is connected via a ribbon cable as shown in Figure C-10.

RCM36/37XX SERIES

Ovnomwvwe BOARI
= vRe

@ o

Figure C-10. Connecting LCD/Keypad Module to RCM3600 Prototyping Board

Note the locations and connections relative to pin 1 on both the RCM3600 Prototyping
Board and the LCD/keypad module.

Z-World offers 2 ft. (60 cm) extension cables. Contact your authorized Z-World distributor
or a Z-World sales representative at +1(530)757-3737 for more information.
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C.8 Sample Programs

Sample programs illustrating the use of the LCD/keypad module with the Prototyping
Board are provided in the SAMPLES\ RCV3600 folder.

These sample programs use the auxiliary 1/0 bus on the Rabbit 3000 chip, and so the
#def i ne PORTA_AUX | Oline is already included in the sample programs.

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program. To run a sample
program, open it with the File menu (if it is not still open), compile it using the Compile
menu, and then run it by selecting Run in the Run menu. The RCM3600 must be in
Program mode (see Section 4.3, “Programming Cable”), and must be connected to a PC
using the programming cable as described in Chapter 2, “Getting Started.”.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

The following sample programs are found in the LCD_KEYPAD folder in
SAMPLES\ RCM3600.

» KEYPADTOLED. G—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a key press is detected. The DS1 and DS2 LEDs on the Prototyping
Board will also light up.

» LCDKEYFUN. G—This program demonstrates how to draw primitive features from the
graphic library (lines, circles, polygons), and also demonstrates the keypad with the key
release option.

* SW TCHTOLED. G—This program demonstrates the use of the external 1/O bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a switch press is detected. The DS1 and DS2 LEDs on the Prototyp-
ing Board will also light up.

Additional sample programs are available in the 122x32_1x7 folder in
SAMPLES\ LCD_KEYPAD.
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C.9 LCD/Keypad Module Function Calls

When mounted on the Prototyping Board, the LCD/keypad module uses the auxiliary 1/0
bus on the Rabbit 3000 chip. Remember to add the line

#def i ne PORTA_AUX_| O
to the beginning of any programs using the auxiliary 1/0 bus.

C.9.1 LCD/Keypad Module Initialization
void displnit();

Initializes the LCD/keypad module. The keypad is set up using keypadDef () or keyConfi g() after
this function call.

RETURN VALUE
None.

C.9.2 LEDs

When power is applied to the LCD/keypad module for the first time, the red LED (DS1)
will come on, indicating that power is being applied to the LCD/keypad module. The red
LED is turned off when the br dl ni t function executes.

One function is available to control the LEDs, and can be found in the RCVMB600. LI B
library in the SAMPLES\ RCVB600 folder.

voi d di spledQut(int led, int value);

LED on/off control. This function will only work when the LCD/keypad module is installed on the
Prototyping Board.

PARAMETERS
| ed is the LED to control.

0=LED DS1
1=LED DS2
2=LED DS3
3=LED DS4
4 = LED DS5
5=LED DS6
6 = LED DS7

val ue is the value used to control whether the LED is on or off (0 or 1).
0 = off
1=on
RETURN VALUE
None.

SEE ALSO
brdlnit
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C.9.3 LCD Display

The functions used to control the LCD display are contained in the GRAPHI C. LI B library
located in the Dynamic C DI SPLAYS\ GRAPHI C library folder. When x and y coordinates
on the display screen are specified, x can range from 0 to 121, and y can range from 0 to
31. These numbers represent pixels from the top left corner of the display.

void gllnit(void);

Initializes the display devices, clears the screen.

RETURN VALUE
None.

SEE ALSO

gl D spOnOFF, gl Backl i ght, gl Set Contrast, gl Pl otDot, gl Bl ock, gl Pl otDot,
gl Pl ot Pol ygon, glPlotGrcle, glHScroll, glVScroll, gl XFontlnit, glPrintf,
gl Put Char, gl SetBrushType, gl BuffLock, gl BuffUnlock, glPlotLine

voi d gl BackLi ght (int onOfif);

Turns the display backlight on or off.
PARAMETER
onO f turns the backlight on or off

1—turn the backlight on
0—turn the backlight off

RETURN VALUE
None.

SEE ALSO
gllnit, gl D spOnoff, gl SetContrast

void gl D spOnOFf(int onOFf);

Sets the LCD screen on or off. Data will not be cleared from the screen.
PARAMETER
onCf f turns the LCD screen on or off

1—turn the LCD screen on
0—turn the LCD screen off

RETURN VALUE
None.

SEE ALSO
gllnit, gl SetContrast, gl BackLi ght

User’s Manual 97



voi d gl Set Contrast (unsi gned | evel);

Sets display contrast.

NOTE: This function is not used with the LCD/keypad module since the support circuits
are not available on the LCD/keypad module.

void gl Fill Screen(char pattern);

Fills the LCD display screen with a pattern.

PARAMETER
The screen will be set to all black if pat t er n is OxFF, all white if pat t er n is 0x00, and vertical stripes
for any other pattern.

RETURN VALUE
None.

SEE ALSO
gl Bl ock, gl Bl ankScreen, gl Pl otPolygon, glPlotCircle

voi d gl Bl ankScreen(voi d);

Blanks the LCD display screen (sets LCD display screen to white).

RETURN VALUE
None.

SEE ALSO
gl Fill Screen, glBlock, glPlotPolygon, glPlotCircle

void gl Block(int x, int y, int bmAdth,
I nt brHei ght) ;

Draws a rectangular block in the page buffer and on the LCD if the buffer is unlocked. Any portion of the
block that is outside the LCD display area will be clipped.

PARAMETERS
X is the x coordinate of the top left corner of the block.
y is the y coordinate of the top left corner of the block.
bmA dt h is the width of the block.
bW dt h is the height of the block.

RETURN VALUE
None.

SEE ALSO
gl Fill Screen, gl Bl ankScreen, gl PlotPolygon, glPlotCircle
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voi d gl Pl ot VPol ygon(int n, int *pFirstCoord);

Plots the outline of a polygon in the LCD page buffer, and on the LCD if the buffer is unlocked. Any
portion of the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are
specified, the function will return without doing anything.

PARAMETERS
n is the number of vertices.
*pFi r st Coor d is a pointer to array of vertex coordinates: x1, y1, x2,y2, x3,y3, ...

RETURN VALUE
None.

SEE ALSO
gl Pl ot Pol ygon, gl Fill Pol ygon, gl Fill VPol ygon

voi d gl Pl ot Pol ygon(int n, int yl, int x2, int y2,
)i

Plots the outline of a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any
portion of the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are
specified, the function will return without doing anything.

PARAMETERS
n is the number of vertices.
y1 is the y coordinate of the first vertex.
x1 is the x coordinate of the first vertex.
y2 is the y coordinate of the second vertex.
x2 is the x coordinate of the second vertex.
. are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
gl Pl ot VPol ygon, gl Fill Pol ygon, gl Fill VPol ygon
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void gl FillVPol ygon(int n, int *pFirstCoord);

Fills a polygon in the LCD page buffer and on the LCD screen if the buffer is unlocked. Any portion of
the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are specified,
the function will return without doing anything.

PARAMETERS
n is the number of vertices.

*pFi r st Coor d is a pointer to array of vertex coordinates: x1, y1, x2,y2, x3,y3, ...

RETURN VALUE
None.

SEE ALSO
gl Fi Il Pol ygon, gl Pl ot Pol ygon, gl Pl ot VPol ygon

void gl FillPolygon(int n, int x1, int yl, int x2,
int y2, ...);

Fills a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are specified, the
function will return without doing anything.

PARAMETERS
n is the number of vertices.
x1 is the x coordinate of the first vertex.
y1 is the y coordinate of the first vertex.
X2 is the x coordinate of the second vertex.
y2 is the y coordinate of the second vertex.
. are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
gl Fi Il VPol ygon, gl Pl ot Pol ygon, gl Pl ot VPol ygon

void glPlotCircle(int xc, int yc, int rad);

Draws the outline of a circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any por-
tion of the circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.
yc is the y coordinate of the center of the circle.
r ad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glFillGrcle, glPlotPolygon, glFillPolygon
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void glFillCrcle(int xc, int yc, int rad);

Draws a filled circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.

yc is the y coordinate of the center of the circle.
r ad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glPlotGrcle, glPlotPolygon, glFillPolygon

voi d gl XFontInit(fontlnfo *plnfo, char pixWdth,
char pi xHei ght, unsi gned start Char,
unsi gned endChar, unsigned |ong xnmenBuffer);

Initializes the font descriptor structure, where the font is stored in xnem
PARAMETERS

*pl nf o is a pointer to the font descriptor to be initialized.

pi xW dt h is the width (in pixels) of each font item.

pi xHei ght is the height (in pixels) of each font item.

st art Char is the value of the first printable character in the font character set.

endChar is the value of the last printable character in the font character set.

xmenBuf f er is the xmempointer to a linear array of font bitmaps.

RETURN VALUE
None.

SEE ALSO
gl Prinf
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unsi gned | ong gl Font Char Addr (font I nfo *pl nf o,
char letter);

Returns the xmemaddress of the character from the specified font set.
PARAMETERS

*pl nf o is the xmemaddress of the bitmap font set.

| etter isan ASCII character.

RETURN VALUE
xmemaddress of bitmap character font, column major, and byte-aligned.

SEE ALSO
gl Put Font, gl Printf

void glPutFont(int x, int y, fontlnfo *plnfo,
char code);

Puts an entry from the font table to the page buffer and on the LCD if the buffer is unlocked. Each font
character's bitmap is column major and byte-aligned. Any portion of the bitmap character that is outside
the LCD display area will be clipped.

PARAMETERS
x is the x coordinate (column) of the top left corner of the text.

y is the y coordinate (row) of the top left corner of the text.
*pl nf o is a pointer to the font descriptor.
code is the ASCII character to display.

RETURN VALUE
None.

SEE ALSO
gl Font Char Addr, gl Printf

voi d gl Set Pf Step(int stepX, int stepY);

Setsthe gl Pri nt f () printing step direction. The x and y step directions are independent signed values.
The actual step increments depend on the height and width of the font being displayed, which are multi-
plied by the step values.

PARAMETERS
st epXisthegl Printf xstep value
stepYisthegl Printf y step value

RETURN VALUE
None.

SEE ALSO
Use gl Get Pf St ep() to examine the current x and y printing step direction.
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int gl Get Pf St ep(voi d);

Gets the current gl Pri nt f () printing step direction. Each step direction is independent of the other,
and is treated as an 8-bit signed value. The actual step increments depends on the height and width of the
font being displayed, which are multiplied by the step values.

RETURN VALUE
The x step is returned in the MSB, and the y step is returned in the LSB of the integer result.

SEE ALSO
Use gl Get Pf St ep() to control the x and y printing step direction.

voi d gl Put Char (char ch, char *ptr, int *cnt,
gl Put Char I nst *pl nst)

Provides an interface between the STDIO string-handling functions and the graphic library. The
STDIO string-formatting function will call this function, one character at a time, until the entire format-
ted string has been parsed. Any portion of the bitmap character that is outside the LCD display area will

be clipped.

PARAMETERS
ch is the character to be displayed on the LCD.

*pt r is not used, but is a place holder for STDIO string functions.
*cnt is not used, is a place holder for STDIO string functions.

*pl nst is a font descriptor pointer.

RETURN VALUE
None.

SEE ALSO
gl Printf, gl PutFont, doprnt
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void glPrintf(int x, int y, fontlnfo *plnfo,
char *fnmt, ...);

Prints a formatted string (much like pr i nt f ) on the LCD screen. Only the character codes that exist in
the font set are printed, all others are skipped. For example, \b', \t', \n"' and \r' (ASCII backspace, tab,
new line, and carriage return, respectively) will be printed if they exist in the font set, but will not have
any effect as control characters. Any portion of the bitmap character that is outside the LCD display area
will be clipped.

PARAMETERS
x is the x coordinate (column) of the upper left corner of the text.
y is the y coordinate (row) of the upper left corner of the text.
*pl nf o is a font descriptor pointer.
*f nt is a formatted string.
. are formatted string conversion parameter(s).

EXAMPLE
glprintf(0,0, &fil1l2x16, "Test %\ n", count);

RETURN VALUE
None.

SEE ALSO
gl XFont I nit

voi d gl Buf f Lock(voi d);

Increments LCD screen locking counter. Graphic calls are recorded in the LCD memory buffer and are
not transferred to the LCD if the counter is non-zero.

NOTE: gl Buf f Lock() and gl Buf f Unl ock() can be nested up to a level of 255, but be
sure to balance the calls. It is not a requirement to use these procedures, but a set of
gl Buf f Lock() and gl Buf f Unl ock() bracketing a set of related graphic calls speeds
up the rendering significantly.

RETURN VALUE
None.

SEE ALSO
gl Buf f Unl ock, gl Swap

voi d gl Buf f Unl ock(voi d);

Decrements the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD
if the counter goes to zero.

RETURN VALUE
None.

SEE ALSO
gl Buf f Lock, gl Swap
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voi d gl Swap(voi d);

Checks the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD if the
counter is zero.

RETURN VALUE
None.

SEE ALSO
gl Buf f Unl ock, gl BuffLock, _gl SwapData (located in the library specifically for the LCD
that you are using)

voi d gl Set BrushType(int type);

Sets the drawing method (or color) of pixels drawn by subsequent graphic calls.

PARAMETER
t ype value can be one of the following macros.

Pl XBLACK draws black pixels (turns pixel on).
Pl XWHI TE draws white pixels (turns pixel off).
Pl XXORdraws old pixel XOR'ed with the new pixel.

RETURN VALUE
None.

SEE ALSO
gl Get BrushType

I nt gl Get BrushType(voi d);

Gets the current method (or color) of pixels drawn by subsequent graphic calls.

RETURN VALUE
The current brush type.

SEE ALSO
gl Set BrushType

void glPlotDot(int x, int y);

Draws a single pixel in the LCD buffer, and on the LCD if the buffer is unlocked. If the coordinates are
outside the LCD display area, the dot will not be plotted.

PARAMETERS
X is the x coordinate of the dot.
y is the y coordinate of the dot.

RETURN VALUE
None.

SEE ALSO
gl Plotline, glPlotPolygon, glPlotCircle
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void gl PlotLine(int x0, int yO, int x1, int yl);

Draws a line in the LCD buffer, and on the LCD if the buffer is unlocked. Any portion of the line that is
beyond the LCD display area will be clipped.

PARAMETERS
x0 is the x coordinate of one endpoint of the line.

y0 is the y coordinate of one endpoint of the line.
x1 is the x coordinate of the other endpoint of the line.

y 1 is the y coordinate of the other endpoint of the line.

RETURN VALUE
None.

SEE ALSO
gl Pl ot Dot, gl Pl ot Polygon, glPlotCircle

void gl Leftl(int left, int top, int cols, int rows);

Scrolls byte-aligned window left one pixel, right column is filled by current pixel type (color).

PARAMETERS
| ef t is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

t op is the top left corner of the bitmap.
col s is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

r ows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl HScroll, glRightl

void glRightl(int left, int top, int cols, int rows);

Scrolls byte-aligned window right one pixel, left column is filled by current pixel type (color).

PARAMETERS
| ef t is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.
t op is the top left corner of the bitmap.
col s is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.
r ows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl HScrol I, glLeftl
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void gl Upl(int left, int top, int cols, int rows);

Scrolls byte-aligned window up one pixel, bottom column is filled by current pixel type (color).

PARAMETERS
| ef t is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

t op is the top left corner of the bitmap.
col s is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

r ows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl VScrol I, gl Downl

void gl Downl(int left, int top, int cols, int rows);

Scrolls byte-aligned window down one pixel, top column is filled by current pixel type (color).

PARAMETERS
| ef t is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

t op is the top left corner of the bitmap.
col s is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

r ows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl VScrol I, gl Upl
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void gl HScroll (int left, int top, int cols,
int rows, int nPiXx);

Scrolls right or left, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. Thel ef t and col s parameters will be verified that they are evenly divisible by 8. If not, they will
be truncated to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.

PARAMETERS
| ef t is the top left corner of bitmap, must be evenly divisible by 8.
t op is the top left corner of the bitmap.
col s is the number of columns in the window, must be evenly divisible by 8.
r ows is the number of rows in the window.

nPi x is the number of pixels to scroll within the defined window (a negative value will produce a scroll
to the left).

RETURN VALUE
None.

SEE ALSO
gl VScrol |
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void gl VScroll (int left, int top, int cols,
int rows, int nPiXx);

Scrolls up or down, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. Thel ef t and col s parameters will be verified that they are evenly divisible by 8. If not, they will
be truncated to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.
PARAMETERS
| ef t is the top left corner of bitmap, must be evenly divisible by 8.
t op is the top left corner of the bitmap.
col s is the number of columns in the window, must be evenly divisible by 8.
r ows is the number of rows in the window.
nPi x is the number of pixels to scroll within the defined window (a negative value will produce a scroll
up).
RETURN VALUE
None.

SEE ALSO
gl HScrol |

void gl XPutBitmap(int left, int top, int wdth,
I nt hei ght, unsigned | ong bitmap);

Draws bitmap in the specified space. The data for the bitmap are stored in xmem This function calls
gl XPut Fast map automatically if the bitmap is byte-aligned (the left edge and the width are each
evenly divisible by 8).

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.
PARAMETERS

| ef t is the top left corner of the bitmap.

t op is the top left corner of the bitmap.

wi dt h is the width of the bitmap.

hei ght is the height of the bitmap.

bi t map is the address of the bitmap in xnem

RETURN VALUE
None.

SEE ALSO
gl XPut Fast map, gl Printf
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voi d gl XPut Fast map(int left, int top, int wdth,
i nt height, unsigned | ong bitmap);

Draws bitmap in the specified space. The data for the bitmap are stored in xrmem This function is like
gl XPut Bi t map, except that it is faster. The restriction is that the bitmap must be byte-aligned.

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.
PARAMETERS

| ef t is the top left corner of the bitmap, must be evenly divisible by 8, otherwise truncates.

t op is the top left corner of the bitmap.

wi dt h is the width of the bitmap, must be evenly divisible by 8, otherwise truncates.

hei ght is the height of the bitmap.

bi t map is the address of the bitmap in xnem

RETURN VALUE
None.

SEE ALSO
gl XPut Bi t map, gl Printf

I nt Text W ndowFr anme(w ndowFr ane *w ndow,
fontInfo *pFont, int x, int y, int winwWdth,
I nt wi nHei ght)

Defines a text-only display window. This function provides a way to display characters within the text
window using only character row and column coordinates. The text window feature provides end-of-line
wrapping and clipping after the character in the last column and row is displayed.

NOTE: Execute the Text W ndowrr ane function before other Text . .. functions.

PARAMETERS

*wi ndowis a window frame descriptor pointer.

*pFont is a font descriptor pointer.

X is the x coordinate of the top left corner of the text window frame.

y is the y coordinate of the top left corner of the text window frame.

wi NW dt h is the width of the text window frame.

Wi nHei ght is the height of the text window frame.
RETURN VALUE

0—window frame was successfully created.

-1—x coordinate + width has exceeded the display boundary.
-2—y coordinate + height has exceeded the display boundary.
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voi d Text Got oXY(wW ndowFrame *w ndow, int col,
i nt row;

Sets the cursor location to display the next character. The display location is based on the height and

width of the character to be displayed.

NOTE: Execute the Text W ndowrr ame function before using this function.

PARAMETERS
*Wi ndow s a pointer to a font descriptor.

col is a character column location.
r owis a character row location.

RETURN VALUE
None.

SEE ALSO
Text Put Char, TextPrintf, TextW ndowFrane

voi d Text Cursor Locati on(w ndowFr ane *w ndow,
int *col, Iint *row);

Gets the current cursor location that was set by a Graphic Text . . . function.

NOTE: Execute the Text W ndowrr anme function before using this function.

PARAMETERS
*Wwi ndowis a pointer to a font descriptor.

*col isa pointer to cursor column variable.
*r owis a pointer to cursor row variable.

RETURN VALUE
Lower word = Cursor Row location
Upper word = Cursor Column location

SEE ALSO
Text Got oXY, TextPrintf, TextWndowFrane, Text CursorlLocation
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voi d Text Put Char (struct w ndowFrane *w ndow, char ch);

Displays a character on the display where the cursor is currently pointing. If any portion of a bitmap
character is outside the LCD display area, the character will not be displayed. The cursor increments its

position as needed.
NOTE: Execute the Text W ndowrr anme function before using this function.

PARAMETERS
*Wi ndow s a pointer to a font descriptor.

ch is a character to be displayed on the LCD.

RETURN VALUE
None.

SEE ALSO
Text Got oXY, TextPrintf, Text W ndowFranme, Text CursorlLocation

void TextPrintf(struct w ndowFrane *w ndow,
char *fnt, ...);

Prints a formatted string (much like pr i nt f ) on the LCD screen. Only printable characters in the font
set are printed, also escape sequences, "\r' and "\n' are recognized. All other escape sequences will be
skipped over; for example, \b" and 't' will print if they exist in the font set, but will not have any effect as
control characters.

The text window feature provides end-of-line wrapping and clipping after the character in the last col-
umn and row is displayed. The cursor then remains at the end of the string.
NOTE: Execute the Text W ndowr ame function before using this function.
PARAMETERS
*Wi ndow s a pointer to a font descriptor.
*f nt is a formatted string.

. are formatted string conversion parameter(s).

EXAMPLE
Text Printf (&Text Wndow, "Test %\ n", count);

RETURN VALUE
None.

SEE ALSO
Text Got oXY, Text Put Char, Text W ndowFr ane, Text CursorlLocation
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C.9.4 Keypad

The functions used to control the keypad are contained in the KEYPAD?. LI B library
located in the Dynamic C KEYPADS library folder.

voi d keylnit(void);

Initializes keypad process

RETURN VALUE
None.

SEE ALSO
brdlnit

voi d keyConfi g(char cRaw, char cPress,
char cRel ease, char cCntHol d, char cSpdLo,
char cCntLo, char cSpdH );

Assigns each key with key press and release codes, and hold and repeat ticks for auto repeat and
debouncing.

PARAMETERS
cRawis a raw key code index.
1x7 keypad matrix with raw key code index assignments (in brackets):
[0] (1] (2] (3]
[4] 5] [6]

User Keypad Interface

cPr ess is a key press code

An 8-bit value is returned when a key is pressed.
0 = Unused.

See keypadDef () for default press codes.
cRel ease is a key release code.

An 8-bit value is returned when a key is pressed.
0 = Unused.

cCnt Hol d is a hold tick, which is approximately one debounce period or 5 ps.

How long to hold before repeating.
0 = No Repeat.

cSpdLo is a low-speed repeat tick, which is approximately one debounce period or 5 ps.

How many times to repeat.
0 = None.

cCnt Lo is a low-speed hold tick, which is approximately one debounce period or 5 ps.

How long to hold before going to high-speed repeat.
0 = Slow Only.
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cSpdHi is a high-speed repeat tick, which is approximately one debounce period or 5 ps.

How many times to repeat after low speed repeat.
0 = None.

RETURN VALUE
None.

SEE ALSO
keyProcess, keyGet, keypadDef

Scans and processes keypad data for key assignment, debouncing, press and release, and repeat.

NOTE: This function is also able to process an 8 x 8 matrix keypad.

RETURN VALUE
None

SEE ALSO
keyConfi g, keyGet, keypadDef

Get next keypress.

RETURN VALUE
The next keypress, or 0 if none

SEE ALSO
keyConfi g, keyProcess, keypadDef

Pushes the value of cKey to the top of the input queue, which is 16 bytes deep.

PARAMETER
cKey

RETURN VALUE
None.

SEE ALSO
keyCet
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voi d keypadDef () ;

Configures the physical layout of the keypad with the default ASCII return key codes.
Keypad physical mapping 1 x 7

0 4 1 5 2 6 3
[L1] [U1] [D1] [R]
[-1 [+] [E1
where

‘D' represents Down Scroll
'U' represents Up Scroll

'R’ represents Right Scroll

'L represents Left Scroll

'—' represents Page Down

"+' represents Page Up

'E' represents the ENTER key

Example: Do the followingfor the above physical vs. ASCII return key codes.

keyConfig ( 3,'R,0, O, 0, 0, 0);
keyConfig ( 6,'"E,0, O, 0, 0, 0);
keyConfig ( 2,'D,0, 0, 0, 0, 0);
keyConfig ( 4,'-',0, 0, 0, 0, 0);
keyConfig ( 1,'U,0, 0, 0, 0, 0);
keyConfig ( 5,'+,0, 0, 0, 0, 0);
keyConfig ( O0,'L',0, O, O, 0, 0);
Characters are returned upon keypress with no repeat.

RETURN VALUE
None.

SEE ALSO
keyConfi g, keyGet, keyProcess

voi d keyScan(char *pcKeys);

Writes "1" to each row and reads the value. The position of a keypress is indicated by a zero value in a bit
position.

PARAMETER

*pcKeys is a pointer to the address of the value read.

RETURN VALUE
None.

SEE ALSO
keyConfi g, keyGet, keypadDef, keyProcess
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APPENDIX D. POWER SUPPLY

Appendix D provides information on the current requirements
of the RCM3600, and includes some background on the chip
select circuit used in power management.

D.1 Power Supplies

Power is supplied from the motherboard to which the RCM3600 is connected via header
J1. The RCM3600 has an onboard +3.3 V linear power regulator that provides the +3.3 V
supply to operate the RCM3600. Figure D-1 shows the power-supply circuit.

J1

57 VBAT_EXT

LINEAR POWER REGULATOR
External
Battery ™S

+3.3V

B LM1117
VIN 3 u7 2
10 uF

10 pF i_ I

POWER
IN

s |88
‘
\

-||—| |—u

Figure D-1. RCM3600 Power Supply

The input voltage range is from 4.0 V to 12.6 V DC. An RCM3600 with no loading at the
outputs typically draws 60 mA when operating at 22.1 MHz.

D.1.1 Battery-Backup Circuits

The RCM3600 does not have a battery, but there is provision for a customer-supplied bat-
tery to back up the data SRAM and keep the internal Rabbit 3000 real-time clock running.

Header J1, shown in Figure D-1, allows access to the external battery. This header makes
it possible to connect an external 3 V battery. This allows the SRAM and the internal Rab-
bit 3000 real-time clock to retain data with the RCM3600 powered down.
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A lithium battery with a nominal voltage of 3 V and a minimum capacity of 165 mA:h is
recommended. A lithium battery is strongly recommended because of its nearly constant
nominal voltage over most of its life.

The drain on the battery by the RCM3600 is typically 6 pA when no other power is sup-
plied. If a 235 mA:h battery is used, the battery can last about 4.5 years:

235 mAh
6 LA

Note that the shelf life of a lithium ion battery is ultimately 10 years. The RCM3600 does
not drain the battery while it is powered up normally.

= 4.5 years.

D.1.2 Reset Generator

The RCM3600 uses a reset generator to reset the Rabbit 3000 microprocessor when the
voltage drops below the voltage necessary for reliable operation. The reset occurs between
2.55V and 2.70 V, typically 2.63 V.

The RCM3600 has a reset pin, pin 36 on header J1. This pin provides access to the reset
output from the reset generator, and is also connected to the reset input of the Rabbit 3000
to allow you to reset the microprocessor externally. A resistor divider consisting of R21
and R22 attenuates the signal associated with an externally applied reset to prevent it from
affecting the reset generator.
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NOTICE TO USERS

Z-WORLD PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE-
SUPPORT DEVICES OR SYSTEMS UNLESS A SPECIFIC WRITTEN AGREEMENT REGARDING
SUCH INTENDED USE IS ENTERED INTO BETWEEN THE CUSTOMER AND Z-WORLD PRIOR
TO USE. Life-support devices or systems are devices or systems intended for surgical implantation into the
body or to sustain life, and whose failure to perform, when properly used in accordance with instructions for
use provided in the labeling and user’s manual, can be reasonably expected to result in significant injury.

No complex software or hardware system is perfect. Bugs are always present in a system of any size. In
order to prevent danger to life or property, it is the responsibility of the system designer to incorporate
redundant protective mechanisms appropriate to the risk involved.

All Z-World products are 100 percent functionally tested. Additional testing may include visual quality con-
trol inspections or mechanical defects analyzer inspections. Specifications are based on characterization of
tested sample units rather than testing over temperature and voltage of each unit. Z-World products may
qualify components to operate within a range of parameters that is different from the manufacturer’s recom-
mended range. This strategy is believed to be more economical and effective. Additional testing or burn-in
of an individual unit is available by special arrangement.
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SCHEMATICS

090-0176 RCM3600 Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0176.pdf

090-0180 Prototyping Board Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0180.pdf

090-0156 LCD/Keypad Module Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0156.pdf

090-0128 Programming Cable Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0128.pdf

The schematics included with the printed manual were the latest revisions available at the
time the manual was last revised. The online versions of the manual contain links to the
latest revised schematic on the Web site. You may also use the URL information provided
above to access the latest schematics directly.
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